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Legal Information

Copyright

Copyright © Shenzhen Inovance Technology Co., Ltd. 2025 All rights reserved

This documentation is the exclusive property of Shenzhen Inovance Technology Co., Ltd.. No
individual or entity may excerpt, reproduce, modify, translate, or distribute any content herein
without written consent from Inovance.

Legal action will be taken against infringement.

Trademarks

is a registered trademark of Shenzhen Inovance Technology Co., Ltd. and its
affiliates. All other trademarks or registered trademarks mentioned in this documentation are the
property of their respective owners. Unauthorized use of these trademarks by third parties for any
purpose without written authorization could violate the rights of their owners.

Disclaimer of Liability

Due to continuous updates and improvements of products and technologies, the content of this
documentation may not fully match the actual products. In the event of any discrepancies, the
actual products shall prevail.

The contents are subject to change without notice due to product upgrade.

Waste Disposal

The storage, use, and disposal of this product (including optional accessories) must comply with
local laws and regulations.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified
for the specific task in accordance with the relevant documentation, in particular its warning notices
and safety instructions. Qualified personnel can identify the risks of the product/system and prevent
possible dangers.

Proper Use of the Product

Proper transportation, storage, assembly, installation, commissioning, operation, and maintenance
are required to ensure the safe operation of the product without any problems. The required
ambient conditions must be met. All operations must follow the guidelines provided in this
documentation.
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Preface

Introduction

This user guide presents installation, wiring, configuration and commissioning, functions, fault
diagnosis, and maintenance of Easy321 and Easy511 series products.

More data
Name Code Description

H5U and Easy Series Programmable
Logic Controller Programming Guide

19012249 Presents the basics of PLC programming,
quick start instructions, communication,
motion control, and instructions for use of
high-speed counters.

H5U and Easy Series Programmable
Logic Controller Instruction Guide

19012250 Presents the basic and complex instructions
used for programming applications, as well
as examples of these instructions.

GE21-RTU Coupler Configuration Card
User Guide

PS00017987 Presents the product information, installation,
wiring, and configuration and commissioning
of the GE21-RTU expansion card.

GE21-CAN-485 Communication
Expansion Card User Guide

PS00017986 Presents the product information, installation,
wiring, and configuration and commissioning
of the GE21-CAN-485 expansion card.

GE21-TF-RTC Memory Expansion Card
(with Integrated RTC) User Guide

PS00017990 Presents the product information, installation,
wiring, and configuration and commissioning
of the GE21-TF-RTC expansion card.

GE21-4AD1DA-I Analog Input and
Output Current-Type Expansion Card
User Guide

PS00021286 Presents the product information, installation,
wiring, and configuration commissioning of
the GE21-4AD1DA-I expansion card.

GE21-8DI Digital Input Expansion Card
User Guide

PS00021287 Presents the product information, installation,
wiring, and configuration commissioning of
the GE21-8DI expansion card.

GE21-8DO-TN Sink-Type Transistor
Output Expansion Card User Guide

PS00021288 Presents the product information, installation,
wiring, and configuration commissioning of
the GE21-8DO-TN expansion card.

GE21-232 485-RTC Communication
Expansion Card User Guide

PS00021289 Presents the product information, installation,
wiring, and configuration commissioning of
GE21-232/485-RTC expansion cards.

GE21-8DO-TP Source-Type Transistor
Output Expansion Card User Guide

PS00021290 Presents the product information, installation,
wiring, and configuration commissioning of
the GE21-8DO-TP expansion card.

GE21-4AD1DA-V Analog Input and
Output Voltage-Type Expansion Card
User Guide

PS00021307 Presents the product information, installation,
wiring, and configuration commissioning of
the GE21-4AD1DA-V expansion card.

Easy321 and Easy511 Series
Programmable Logic Controller User
Guide (This guide)

PS00017976 Presents installation, wiring, configuration
commissioning, functions, fault diagnosis,
and maintenance of Easy321 and Easy511
series products.
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Standards Compliance

The following table lists the certifications, directives, and standards that the product may comply
with. For details about the acquired certificates, see the certification marks on the product
nameplate.

Name Directive Standard
CE EMC 2014/30/EU 24 VDC products:

EN 611312

220 VAC products:

EN 61131-2

EN 61000-3-2

EN 61000-3-3
LVD 2014/35/EU EN 61010-1

EN 61010-2-201
RoHS directive 2011/65/EU amended by

(EU)2015/863
EN IEC 63000

UL/cUL - UL 61010-1

UL 61010-2-201

CAN/CSA-C22.2 No. 61010-1

CSA C22.2 NO. 61010-2-201
KCC - -
EAC
certification

- -

UKCA Safety Regulations Electrical Equipment
(Safety) Regulations
2016

EN 61010-1

EN 61010-2-201

EMC regulation Electromagnetic
Compatibility
Regulations 2016

24 VDC products:

EN 61131-2

220 VAC products:

EN 61131-2

EN 61000-3-2

EN 61000-3-3
RoHS regulation Directive (RoHS)

Regulations 2012
EN IEC 63000

Revision History

Date Version Revision
August 2025 A03 Made minor corrections.

July 2025 A02 Updated “2.4.5 Communication
Specifications” on page 20.

June 2025 A01 Made minor corrections.
May 2025 A00 Initial release.

Access to the Guide

This guide is not delivered with the product. You can obtain the PDF version in the following ways

● Do keyword search under Service and Support at www.inovance.com.
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● Scan the QR code on the product with your smart phone.
● My Inovance APP: Scan the QR code below to install the app, where you can search for and

download user guides.

Warranty disclaimer

Inovance provides warranty service within the warranty period (as specified in your order) for any
fault or damage that is not caused by improper operation of the user. Maintenance can be charged
after the warranty period expires.

Within the warranty period, maintenance can be charged for the following damage:

● Damage caused by operations not following the instructions in the user guide
● Damage caused by fire, flood, or unusual voltage
● Damage caused by unintended use of the product
● Damage caused by use beyond the specified scope of application of the product
● Damage or secondary damage caused by force majeure (natural disaster, earthquake, and

lightning strike)

The maintenance is charged according to the latest Price List of Inovance. If otherwise agreed upon,
the terms and conditions in the agreement shall prevail.

For details, see Product Warranty Card.
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1 Fundamental Safety Instructions

1.1 Fundamental Safety Instructions

Safety Precautions

1. Read and follow the safety instructions when installing, operating, and maintaining the
equipment.

2. To ensure your safety and prevent damage to the equipment, follow the marks on the equipment
and all the safety instructions in this guide.

3. "CAUTION", "WARNING", and "DANGER" items in this guide do not indicate all safety precautions
that need to be followed; instead, they just supplement the safety precautions.

4. Use this equipment according to the designated environment requirements; otherwise, a fault
may occur. Malfunction or damage caused by improper use is not covered by warranty.

5. Inovance shall take no responsibility for any personal injury or property damage caused by
improper use.

Safety Levels and Definitions

"DANGER" indicates that failure to comply with the notice can result in death or severe
personal injury.

"WARNING" indicates that failure to comply with the notice may result in death or severe
personal injury.

"CAUTION" indicates that failure to comply with the notice may result in minor or moderate
personal injury or equipment damage. Keep this user guide properly for future use and deliver
it to the end user.

Control system design

● Provide a safety circuit outside the PLC so that the control system can still work safely once
external power failure or controller fault occurs.
● Add a fuse or circuit breaker because the module may smoke or catch fire due to long-time
overcurrent caused by operation above rated current or load short-circuit.

● An emergency stop circuit, a protection circuit, a forward/reverse operation interlocked circuit,
and an upper position limit and lower position limit interlocked circuit must be set in the external
circuits of PLC to prevent damage to the equipment.
● To ensure safe operation, for the output signals that may cause critical accidents, use external
protection circuit and safety mechanism.
● Once the CPU of the controller detects an exception in the system, all outputs may be closed.
When a fault occurs in the controller circuit, the output may not be under control. Therefore, it is
necessary to set up an external control circuit to ensure normal operation.
● If the output units such as relays or transistors are damaged, the output may fail to switch
between ON and OFF states according to the commands.
● The PLC is designed to be used in an indoor electrical environment (overvoltage category II). The
power supply must have a system-level surge protector, assuring that overvoltage due to lightning
shock cannot be applied to the PLC's power supply input terminals, signal input terminals, and
output terminals, to prevent damage to the equipment.

Installation
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● Installation must be carried out by skilled personal who have undergone specialized electrical
training and possess comprehensive electrical expertise.
● Disconnect all external power supplies of the system before disassembling the module. Failure to
do so may result in electric shock, module fault, or malfunction.
● Do not use the PLC in environments with dust, greasy smoke, conductive dust, corrosive or
combustible gases, exposed to high temperature, condensation, wind & rain, or subject to
vibration and shock. Electric shock, fire, and malfunction may also result in damage or
deterioration to the product.
● The PLC is open-type equipment that must be installed in a control cabinet with lock (cabinet
housing protection > IP20). Only the skilled personnel who have undergone specialized electrical
training and possess comprehensive electrical expertise can open the cabinet.

● Prevent metal filings and wire ends from dropping into ventilation holes of the PLC during
installation. Failure to comply may result in fire, fault, and malfunction.
● Ensure there are no foreign matters on ventilation surface. Failure to comply may result in poor
ventilation, which may cause fire, fault and malfunction.
● Ensure the module is connected to the respective connector securely and hook the module firmly.
Improper installation may result in malfunction, fault, or fall-off.

During wiring

● Wiring must be carried out by skilled personnel who have undergone specialized electrical
training and possess comprehensive electrical expertise.
● Disconnect all external power supplies of the system before wiring. Failure to comply may result
in electric shock, module fault, or malfunction.
● Insulate the cable terminals properly to ensure the insulation distance between cables will not be
shortened after cables are connected to the terminal block. Failure to comply may result in electric
shock or damage to the equipment.

● To avoid electric shock, cut off the power supply before connecting the product to the power
supply.
● The input power of the product must meet the specifications listed in this guide. If the power input
does not meet the specifications, the equipment may be damaged. Thus, check regularly that the
DC power provided by the switching-mode power supply unit is stable.

Operation and Maintenance

● Operation and maintenance must be carried out by skilled personnel who have undergone
specialized electrical training and possess comprehensive electrical expertise.
● Do not touch the terminals while the power is on. Failure to comply may result in electric shock or
malfunction.
● Disconnect all external power supplies of the system before cleaning the module. Failure to
comply may result in electric shock.
● Disconnect all external power supplies of the system before assembling/disassembling the
module or connecting/removing the communication cables. Failure to comply may result in
electric shock or malfunction.
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Safety Recommendations

● In the position where the operator directly touches the machinery part, for example, where a
machinery tool is loaded/unloaded, or where a machine runs automatically, the on-site manual
operating devices and any other alternative means must be carefully arranged and designed so
that they are independent of the PLC and can start or terminate the automatic running of the
system.
● If modification on the program is needed during system operation, use the lock function or other
protective measures. Ensure that only authorized personnel can make the necessary
modifications.

Disposal

● Dispose of the retired product as industrial waste. Dispose of the battery according to local laws
and regulations.
● Recycle retired equipment by observing industry waste disposal standards to avoid
environmental pollution.

1.2 Industrial Information Safety

The product provides an interface to connect to the network and transmit data through the network
interface. To protect factories, systems, machines, and networks from cyber-attacks, a proper
industrial information security protection mechanism must be implemented to ensure safe operation
of factories, systems, machines, and networks.

The customer is responsible for providing and continuously ensuring a secure connection between
the product and the customer network or any other network to prevent unauthorized access to its
factories, systems, machines, and networks. The system and device can be connected to the
corporate network or Internet only when they are connected securely with appropriate security
measures taken (for example, anti-virus software and firewall installation).

Inovance is committed to continuous development and improvement of the products and solutions
to improve the level of safety. It is strongly recommended to update the product promptly and
always use the latest version.

Tampering with software (such as viruses, Trojans, and Worms) can lead to unsafe drive state, which can put the
device in an unsafe operation state. This may result in death, serious injury, and property damage. Observe the
following strictly.

● Always use the latest software version. If the product version is no longer supported or the latest version of
the program is not applied, customers are at increased risk of cyber-attacks.

● Take proper protection measures (including but not limited to deploying anti-virus software, firewall, WAF,
IPS/IDS, situational awareness system, ID verification, and data encryption) to prevent files in the mobile
storage device from being damaged by malware and protect products, networks, systems, and interfaces
from unauthorized access, disturbance, intrusion, data disclosure, or information theft.

● Check all safety-related interfaces and settings after commissioning.
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2 Product Introduction

2.1 Product Overview

Easy321 and Easy511 are small-sized PLCs developed based on the AutoShop programming
platform of Inovance. The motion control instructions comply with PLCopen specifications and
support multiple programming languages including ST, LD, and SFC. A massive number of I/O points
are available on the CPU.

Easy321 series PLCs carry one Ethernet port and are available in two models, 60-point model and
40-point model, both of which are further divided into the relay type, PNP type, and PNP type.
Easy511 series PLCs carry one EtherCAT port and are available in two models, 60-point NPN model
and 40-point NPN model. The Easy511 series PLC supports Ethernet switchover and carries GE21-EN
Ethernet card to support standard Ethernet communication protocol.

The GE21 expansion cards include the GE21-RTU configuration expansion card, GE21-CAN-485
communication expansion card, and GE21-TF-RTC storage expansion card. A wide range of models
and expansion cards are available to meet various applications.

Highlights of Easy321

The Easy321 series PLC is mainly applied in logic control and process control. It can be used as smart
remote I/O and features the following highlights.

● Dual-core processor, nanoseconds instruction processing speed
● 256 KB user program; 1 MByte custom variables (in which 128 KB are retentive at power failure);

about 150 K soft components (soft components numbered above 1000 are retentive at power
failure)

● Ethernet x 1; Modbus TCP, OPC UA (server), Socket, and EtherNet/IP, and PN (slave) supported
● Up to eight GL20 local expansion modules supported without the GL20-PS2 power supply

module; up to fifteen GL20 local expansion modules supported with the GL20-PS2 power supply
module

● Two expansion card slots, with slot A for GE21-CAN-485 expansion card and slot B for GE21-TF-
RTC or GE21-RTU expansion card (See “2.4.1 General specifications” on page 13 for the complete
list of expansion card models supported.)

● Multiple programming languages including ST, LD, and SFC supported; built-in ST execution
block in the ladder diagram, FB, FC, structures, unions, and arrays supported; virtual simulation
supported by the programming software

● Configuration as smart I/O supported through GE21–RTU expansion card without the need for
software configuration

Highlights of Easy511

The Easy511 series PLC is mainly applied to bus motion control applications. It features the following
highlights.

● Dual-core processor, nanoseconds instruction processing speed
● 256 KB user program; 1 MByte custom variables (in which 128 KB are retentive at power failure);

about 150 K soft components (soft components numbered above 1000 are retentive at power
failure)
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● Ethernet x 1; Modbus TCP, OPC UA (server), Socket, and EtherNet/IP, and PN (slave) supported
● EtherCAT x 1; 8 axes (including pulse axis) in the cycle synchronization mode; 12 axes in the

profile mode; up to 72 slaves supported; switchover to Ethernet supported
● Up to eight GL20 local expansion modules supported without the GL20-PS2 power supply

module; up to fifteen GL20 local expansion modules supported with the GL20-PS2 power supply
module

● Two expansion card slots, with slot A for GE21-EN expansion card and slot B for GE21-TF-RTC or
GE21-4AD1DA-I expansion card (See “2.4.1 General specifications” on page 13 for the complete
list of expansion card models supported.)

● Multiple programming languages including ST, LD, and SFC supported; built-in ST execution
block in the ladder diagram, FB, FC, structures, unions, and arrays supported; virtual simulation
supported by the programming software

For details about Easy321 and Easy511, see “2.3 Model and Nameplate” on page 12.

2.2 System Networking

The Easy321 and Easy511 series PLCs support Modbus TCP, EtherNet/IP, OPC UA (Server), PN (Slave),
and Socket communication protocols. You can connect the PLC to other stations, ERP, MES, and other
systems through a switch. The Easy511 series PLC is equipped with the EtherCAT communication
function by default to control operations of the servo drives, AC drives and remote I/Os. The Easy321
series PLC can support CAN communication through a expansion card to connect to the servo drive
and AC drive.

The following figure shows a typical system networking diagram.

The Easy321 series PLC can be configured as a PN remote I/O through the GE21-RTU coupler
configuration card to back up the configuration information of the PLC that used as I/O.
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2.3 Model and Nameplate

Model description

Take the Easy321-3624ER model as an example. The model description is shown as follows.

① Product series

Easy: Easy series programmable logic
controller

④ Number of outputs

24: 24 outputs

16: 16 outputs

② Product model

321: Easy300 series product model

511: Easy500 series product model

⑤ Output type

ER: Relay

TN: Sink-type transistor

TP: Source-type transistor

③ Number of inputs

36: 36 inputs

24: 24 inputs

–

Nameplate description

Take the Easy321-3624ER model as an example. The nameplate description is shown in the
following figure. For information about the nameplates of other models, see “2.4.2 Power Supply
Specifications” on page 16, “2.4.3 Input Specifications” on page 17, and “2.4.4 Output Specifications”
on page 19.
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Model Description Material code

Easy321-3624ER Easy300 series programmable controller with 36 inputs and
24 relay outputs

01440709

Easy321-3624TP Easy300 series programmable controller with 36 inputs and
24 transistor source outputs

01440710

Easy321-3624TN Easy300 programmable controller with 36 inputs and 24
transistor sink outputs

01440711

Easy321-2416ER Easy300 series programmable controller with 24 inputs and
16 relay outputs

01440715

Easy321-2416TP Easy300 series programmable controller with 24 inputs and
16 transistor source outputs

01440716

Easy321-2416TN Easy300 programmable controller with 24 inputs and 16
transistor sink outputs

01440717

Easy511-3624TN Easy500 series programmable controller with 36 inputs and
24 transistor sink outputs (slot A for EN card)

01440944

Easy511-2416TN Easy500 series programmable controller with 24 inputs and
16 transistor sink outputs (slot A for EN card)

01440945

2.4 Technical Specifications

2.4.1 General specifications

Item

Specification

Easy321-3624ER Easy321-2416ER Easy321-

3624TN/TP

Easy321-

2416TN/TP

Easy511-

3624TN

Easy511-2416TN

Dimensions (W x H x D)
205 mm x 100

mm x 75 mm

155 mm x 100

mm x 75 mm

205 mm x

100 mm x 75

mm

155 mm x 100

mm x 75 mm

205 mm x 100

mm x 85 mm

155 mm x 100

mm x 85 mm

Weight About 750 g About 630 g About 615 g About 525 g About 635 g About 545 g

Program data capacity

● 256 KB user program
● 1 Mbyte custom variables, in which 128 KB are retentive at power failure
● About 150 K soft components, in which those numbered above 1000 are retentive at power failure
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Item

Specification

Easy321-3624ER Easy321-2416ER Easy321-

3624TN/TP

Easy321-

2416TN/TP

Easy511-

3624TN

Easy511-2416TN

Instruction

processing

speed

Instruction speed 20 K steps with 2 ms scan cycle

Bit operation 0.144 μs/instruction

Word

transmission
0.338 μs/instruction

Floating-point

operation
0.779 μs/instruction

High-speed I/

O

High-speed input
Pulse input supported, max. 4 axes (encoder axis)/8-channel 200 K, AB phase supported, pulse+direction,

CW/CCW, unidirectional counting

High-speed

output
Not supported

Pulse input supported, max. 4 axes (pulse axis, unified instruction

with bus axis)/8-channel 200 K, AB phase supported,

pulse+direction, CW/CCW, PWM pulse width modulation (4-channel)

supported

Expansion

module and

expansion

card

Local expansion

module

● Up to eight GL20 local expansion modules supported without GL20-PS2 power supply
● Fifteen GL20 local expansion modules supported with GL20-PS2 power supply (The number of expansion
modules must be calculated based on the bus current consumption [1].)

Expansion card

● GE21-RTU expansion card that allows the PLC to be quickly configured as a PN coupler
● GE21-RTU expansion card that backs up the configuration information of the PLC when it is used as smart
I/O; original parameters downloaded automatically after PLC replacement

Two expansion card slots available

● Slot A for the following expansion card models: GE21-CAN-485,
GE21-4AD1DA-I, GE21-4AD1DA-V, GE21-EN, GE21-WIFI, GE21-8DI,
GE21-8DO-TN, GE21-8DO-TP
● Slot B for the following expansion card models: GE21-4AD1DA-I,
GE21-4AD1DA-V, GE21-232/485-RTC, GE21-TF-RTC, GE21-RTU, GE21-
8DI, GE21-8DO-TN, GE21-8DO-TP

Two expansion card slots

available

● Slot A for GE21-EN Ethernet card
as standard, with 100 Mbps
Ethernet supported
● Slot B for the following
expansion card models: E21-
4AD1DA-I, GE21-4AD1DA-V, GE21-
232/485-RTC, GE21-TF-RTC, GE21-
RTU, GE21-8DI, GE21-8DO-TN,
GE21-8DO-TP

PLC program/

firmware update
Updated through GE21-TF-RTC expansion card
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Note
[1]:

● The following requirements must be met when connecting the expansion module. Otherwise, the GL20-PS2
module power supply must be added to the right side of the corresponding module before the limit is
exceeded.

● The total power consumption of the expansion module does not exceed the PLC bus power supply current
of 1 A.

● The number of expansion modules does not exceed eight.

● Calculation example: Expansion of eight GL20-0808ETN (power consumption: 130 mA) + seven GL20-8ADI
(power consumption: 65 mA) expansion modules. For detailed power consumption of each module, see “9.3
Appendix 3: Applicable Products” on page 99.

● Total power consumption of the expansion I/O modules = 130 mA x 8 + 65 mA x 7 = 1495 mA (Total power
consumption of the expansion modules = Power consumption of expansion module 1 + Power
consumption of expansion module 2 +... + Power consumption of expansion module n.)

● Check whether the power consumption and number of expansion modules exceed the limit.

● The current bus power consumption is 1495 mA, which exceeds the PLC power supply capacity of 1A.
● The current number of expansion modules is 15, which exceeds the maximum permissible number of 8.

● Check the configuration form.

In conclusion, the PLC cannot support the above configuration. The GL20-PS2 module must be added

to the right side of the 7th module. The total power consumption of the module with the PLC is 965 mA

(130 mA x 7 + 55 mA x 1 = 965 mA). The power consumption of GL20-PS2 is 55 mA. The total number of

expansion modules is 16. The system configuration is shown in the following figure.
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2.4.2 Power Supply Specifications

Item

Specification

Easy321-

3624ER

Easy321-2416ER Easy321-

3624TN/TP

Easy321-

2416TN/TP

Easy511-

3624TN

Easy511-

2416TN

Power supply

input

Rated voltage

220 VAC input, voltage range: 85

VAC to 264 VAC

For voltages between 85 VAC to

100 VAC/240 VAC to 264 VAC,

derate the load by 50%, as shown

below.

24 VDC input, voltage range: 21.6 VDC to 26.4 VDC

Rated current 1 A 1 A (max.@24 V)

Power

supply

protection

Short circuit

supported
Supported

Reversed

polarity

protection

Supported

Power supply

output

Rated voltage 20.4 VDC to 26.4 VDC

Maximum current 0.3 A

Local bus Rated current 1 A, up to 8 local expansion modules supported

Hot swap Not supported

For safety reasons, derate the PLC under undervoltage and high voltage environments based on the
following derating curves.
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2.4.3 Input Specifications

Digital input

Item

Specification

Easy321-

3624ER

Easy321-

2416ER

Easy321-

3624TN/TP

Easy321-

2416TN/TP

Easy511-

3624TN

Easy511-

2416TN

High-

speed DI

terminal

Input type Digital input

Input mode Source/Sink

Number of input channels 8-channel (high-speed)

Input voltage class 24 VDC±10% (21.6 VDC to 26.4 VDC)

High-speed

input

(X0-X7)

Input current

at input ON
Input current > 4 mA

Input current

at input OFF
Input current < 2.5 mA

Hardware

response

time

2 μs (RC time)

Maximum

input

frequency

200 kHz

Input

resistance
3.3 kΩ

ON voltage >15 VDC

OFF voltage < 5 VDC

Software filter time High speed: 200 ns to 1000 μs

Common terminal mode
The common terminal is shared by all the DIs (polarity (+/-) of the input power supply can be

changed).

Input derating For details, see “2.6 Derating Specifications” on page 25.
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Item

Specification

Easy321-

3624ER

Easy321-

2416ER

Easy321-

3624TN/TP

Easy321-

2416TN/TP

Easy511-

3624TN

Easy511-

2416TN

Regular

DI

terminal

Input type Digital input

Input mode Source/Sink

Number of input channels
28 channels

(regular)

16 channels

(regular)

28 channels

(regular)

16 channels

(regular)

28 channels

(regular)

16 channels

(regular)

Input voltage class 24 VDC±10% (21.6 VDC to 26.4 VDC)

Standard

input

Input current

at input ON
4 mA (typical@24 V)

Hardware

response

time upon

ON/OFF

100 μs/100 μs

Maximum

input

frequency

250 Hz

Input

resistance
5.6 kΩ

ON voltage >15 VDC

OFF voltage < 5 VDC

Software filter time Low speed: 2 ms to 1000 ms

Common terminal mode
The common terminal is shared by all the DIs (polarity (+/-) of the input power supply can be

changed).

Input derating For details, see “2.6 Derating Specifications” on page 25.
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2.4.4 Output Specifications

Digital output

Item
Specification

Easy321-3624TN/TP Easy321-2416TN/TP Easy511-3624TN Easy511-2416TN

High-speed output

terminal

Output type Digital output (transistor)

Output mode Sink (NPN)/Source (PNP) Sink (NPN)

Number of output

channels
8-channel (high-speed)

Output voltage class 24 VDC±10% (21.6 VDC to 26.4 VDC)

Output

load

Resistive

load
0.5 A/point; 2 A/8 points

Inductive

load
7.2 W/point; 24 W/8 points

Lamp load 5 W/point; 18 W/8 points

Hardware response time

upon ON/OFF
< 1 μs (OFF→ON); < 2 μs (ON→OFF)

Load current

requirements
Load current ≥ 12 mA when used with outputs greater than 10 kHz

Maximum output

frequency
Resistive load: 200 kHz; inductive load: 0.5 Hz; lamp load: 10 Hz

PWM output

Maximum frequency: 200 kHz; minimum pulse width: 2.5 μs; minimum resolution: 2.5 μs,

adjustable duty cycle: 0.01% to 99.99% (The duty cycle is related to the frequency. The pulse

width corresponding to the duty cycle cannot be lower than the minimum pulse width.)

Regular output

terminal

Output type Digital output (transistor)

Output mode Sink (NPN)/Source (PNP) Sink (NPN)

Number of output

channels
16 channels (regular) 8 channels (regular) 16 channels (regular) 8 channels (regular)

Output voltage class 24 VDC±10% (21.6 VDC to 26.4 VDC)

Output

load

Resistive

load
0.5 A/point; 2 A/8 points

Inductive

load
7.2 W/point; 24 W/8 points

Lamp load 5 W/point; 18 W/8 points

Hardware response time

upon ON/OFF
100 μs/100 μs

Switching frequency Resistive load: 100 Hz; inductive load: 0.5 Hz; lamp load: 10 Hz

Leakage current upon OFF < 10 μA at rated 24 V

Maximum residual voltage upon ON < 0.5 VDC

Common terminal mode 8 points/common terminal

Short circuit protection Available per channel

External inductive load protection A flywheel diode is required when an external inductive load is connected.

Output derating For details, see “2.6 Derating Specifications” on page 25.
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Specifications of relay-type output

Item
Specification

Easy321-3624ER Easy321-2416ER

DO terminals

Output type Relay output

Output mode Dry contact

Number of output channels 24 channels (regular) 16 channels (regular)

Output voltage class 250 VAC/30 VDC

Output load

Resistive load 2 A/point; 8 A/4 points

Inductive load 220 VAC, 80 VA

Lamp load 220 VAC, 100 W; 24 VDC, 30 W

Hardware response time

upon ON/OFF
Approx. 15 ms

Minimum load 5 VDC, 100 mA

Switching frequency No more than 20 operations per minute

Mechanical life 5000000 operations

Electrical service life 100000 operations (≤ 2 A)

Output derating For details, see “2.6 Derating Specifications” on page 25.

2.4.5 Communication Specifications

Ethernet specifications

Item

Specification

Easy321-

3624ER
Easy321-2416ER Easy321-3624TN/TP Easy321-2416TN/TP Easy511-3624TN Easy511-2416TN

Number of channels

supported
One Ethernet channel

One Ethernet channel and one

EtherCAT channel

Network media
Flexible crossover cable, double-shielded (SFTP or SFTPP), Cat5e or above (For details, see “4.2.2 Wiring
Preparation” on page 48.)

Duplex mode Full duplex

Hardware terminal Single network port RJ45

Baud rate 10 Mbps/100 Mbps

Communication

distance
≤ 100 m

Protocol

● EtherNet/IP protocol and master-slave (up to 32 slaves) mode supported
● Maximum data volume for an individual communication: 1400 bytes

Modbus TCP protocol supported, serving as a master or slave, up to 31 slaves supported

FINS slave supported

Socket

OPC UA protocol supported, serving as a server only

Serving as a PN slave only, up to 16 modules supported
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EtherCAT specifications

Item
Specification

Easy511-3624TN Easy511-2416TN

Number of network

port

1

Communication

protocol

EtherCAT protocol

Services available FoE, CoE (PDO, SDO)

Synchronization

mode

● DC synchronization
● SM synchronization
● Custom DC mode

For details about terms, see “ Term” on page 101.

Physical layer 100Base-TX

Baud rate 100 Mbps

Duplex mode Full duplex

Topology ● Bus topology
● Star topology

Transmission

medium
Flexible crossover cable, double-shielded (SFTP or SFTPP), Cat5e or above (For details, see “4.2.2 Wiring
Preparation” on page 48.)

Transmission

distance

Less than 100 m between two nodes

EtherCAT frame

length

44 bytes to 1498 bytes

Process data Up to 1486 bytes per Ethernet frame

Automatic scanning Supported

Number of axes Up to 12 axes, in which 8 axes for cyclic synchronization mode (including pulse axis) and 4 axes for profile mode

Number of slaves Up to 72 slaves supported

Cam Synchronous operation of 8 groups of cams supported

End-to-End network

integration
End-to-end network integration supported

Disable and scan Disabling and scanning of slaves supported

RS485 specifications

Item

Specification

Easy321-

3624ER
Easy321-2416ER Easy321-3624TN/TP

Easy321-2416TN/

TP
Easy511-3624TN

Easy511-

2416TN

Number of channels

supported

RS485 x 11 (1 built-in channel + 2 channels provided by expansion card + 8

channels provided by local expansion module)

RS485 x 11 (1 built-in channel + 2

channels provided by expansion card

+ 8 channels provided by local

expansion module)

Hardware terminal 3-pin terminal on the user side

Isolation Not supported
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Item

Specification

Easy321-

3624ER
Easy321-2416ER Easy321-3624TN/TP

Easy321-2416TN/

TP
Easy511-3624TN

Easy511-

2416TN

Termination resistor None (external termination resistor needed), serving as a master or slave

Number of slaves
Up to 31 slaves supported (Each branch line distance must be shorter than 3 m as shown in “4.4.3 Terminal Wiring”
on page 64.)

Communication baud

rate
9600 bps, 19200 bps, 38400 bps, 57600 bps, and 115200 bps supported

Short circuit protection Providing protection against incorrect 24 V connection

Protocol Serial free protocol, Modbus ASCII protocol (master-slave), and Modbus-RTU protocol (master-slave) supported

CAN specifications

The GE21‑CAN‑485 expansion card supports the CAN protocol. For details, see GE21‑CAN‑485
Communication Expansion Card User Guide.

Item

Specification

Easy321-

3624ER

Easy321-2416ER Easy321-3624TN/TP Easy321-2416TN/TP Easy511-3624TN Easy511-

2416TN

Number of channels

supported
One channel can be provided by the expansion card.

-Protocol CANlink and CANopen protocols supported

Slave
● CANlink: Up to 63 slaves supported
● CANopen: Up to 30 slaves supported

USB specifications

Item

Specification

Easy321-

3624ER

Easy321-2416ER Easy321-3624TN/TP Easy321-2416TN/TP Easy511-3624TN Easy511-

2416TN

Number of channels

supported
1

USB cable distance 1.5 m

USB communication

version
USB 2.0 at full speed

USB hardware

interface
Type-C interface

Function Monitoring, online editing, program upload/download, and firmware update

Network port specifications

Note
● The Easy511 series PLC is equipped with a GE21-EN Ethernet card as standard and supports dual network

ports.
● The Easy321 series PLC supports a single network port.
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Item Built-in network port (Ethernet 0) Expansion network port

(Ethernet 1)

Description

Default IP ● Easy511: 192.168.2.88
● Easy321: 192.168.1.88

Easy511: 192.168.1.88 -

IP conflict

detection

Supported Supported -

Cross-segment IP

adjustment

Supported Supported -

System variable-

based adjustment

Supported Supported -

Modbus TCP Supported Supported -

ОPC UA Supported Supported Use either built-in or expansion network

port, but not both.

EtherNet/IP Supported Supported Use either built-in or expansion network

port, but not both.

FINS Supported Supported -

PN Supported Supported Use either built-in or expansion network

port, but not both.

EtherCAT

switchover

● Easy511: EtherCAT for built-in network port
by default, which can be switched to
Ethernet
● Easy321: EtherCAT not supported

Not supported -

TCP/UDP

instruction

Supported Supported -

Monitoring

protocol

Supported Supported -

MC protocol Supported Supported For details on MC protocol configuration

and applicable specifications, see section

MC Communication in H5U&Easy Series

Programmable Logic Controller

Programming Guide.

Program upload/

download

Supported Supported -

Firmware update Supported Supported -

2.4.6 Function Specifications

Item

Specification

Easy321-

3624ER

Easy321-

2416ER

Easy321-

3624TN/TP

Easy321-

2416TN/TP

Easy511-

3624TN
Easy511-2416TN

Programming language LD, ST, SFC, and FB/FC function (LD)

Program conversion tool Used to switch programs of H1U, H2U, or H3U to Easy series PLC quickly.

Subprogram supported Subprogram encryption is supported. Separate network encryption is not supported.

Program encryption (function block

encryption)
FB/FC program encryption
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Item

Specification

Easy321-

3624ER

Easy321-

2416ER

Easy321-

3624TN/TP

Easy321-

2416TN/TP

Easy511-

3624TN
Easy511-2416TN

Programmodification during

operation

Online modification is supported, in which all instructions can be modified online. However,

configurations cannot be modified online. Subprograms cannot be deleted online.

Cam, gear, and interpolation Not supported Supported

Project configuration software Autoshop

User program

upgrade

USB
Supports Type-C interface for PLC program upload/download and monitoring without external power

supply.

Micro SD
Supports Micro SD card user program download. For details, see “8.3.2 Downloading User
Program from Micro SD Card” on page 95.

HMI

(Inovance)
Supports user program download.

Firmware upgrade/

programming

USB Supports Type-C interface for PLC firmware upgrade/programming without external power supply.

Micro SD Supports user program upgrade.

Other features

The GE21-RTU card can be used to quickly configure Easy321 as smart

I/O to serve as a PN slave. For details, see “6.1 PN Coupler Mode”
on page 76.

–

The number of I/O points on the PLC can be expanded, as described in “6.3 Expansion of Local I/O
Points” on page 79.

2.5 Environmental Specifications

Item Specification

Installation/Operating environment
Free from conductive dust, conductive fibers, explosive dust, flammable gases, water mist/greasy dirt,

corrosive dust/gases, strong vibration, and repetitive shock

Altitude ≤ 2000 m

IP rating IP20

Pollution degree 2

Immunity 4 kV for AC power cables and 2 kV for DC power cables (IEC61000-4-4)

Overvoltage category Relay model: II; non-relay model: I

EMC immunity level Zone B, IEC61131-2

ESD protection level Contact discharge +/-6 kV, air discharge +/-8 kV

Vibration resistance

● Application scenario: Tested according to IEC60068-2-6. 3.5 mm amplitude at 5 Hz to 8.4 Hz; 1 g
gravitational acceleration at 8.4 Hz to 200 Hz; in ten cycles/axes
● Transportation scenario: Tested according to IEC60068-2-64, 0.01 g2/Hz power spectral density at 5 Hz
to 100 Hz; 0.001 g2/Hz power spectral density at 200 Hz; 1.14 g Grms

Shock resistance
Application/Transportation scenario: Tested according to IEC60068-2-27; 15 g peak acceleration, 11 ms

pulse width, 18 cycles in total in X, Y and Z axial directions

Ambient temperature/humidity

● Temperature:
Single PLC: -20°C to +60°C
Parallel PLCs: -20°C to +55°C
● Humidity: < 95% RH (30℃), without condensation
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Item Specification

Storage temperature/humidity
● Temperature: -20°C to +60°C
● Humidity: < 95% RH (30℃), without condensation

Transportation temperature/

humidity

● Temperature: -40°C to +70°C
● Humidity: < 95% RH (40℃), without condensation

Installation mode

and limit

Mounting

method
For details, see “3.1.2 Mounting Method” on page 31.

Installation

limit
For details, see “2.6 Derating Specifications” on page 25.

Note
The temperature required for vertical installation is 10℃ lower than that for horizontal installation.

2.6 Derating Specifications

For requirements on the installation/ambient environment, see “2.5 Environmental Specifications”
on page 24.
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Type Item Input/output load derating curve

Single PLC

(with

expansion

card)

● Single PLC: Without
expansion module and
with two expansion
cards (not derated)
● Operating conditions:
CPU load rate of 80% or
below
● The installation
temperature for a
vertically-mounted PLC
is 10℃ lower than a
horizontally-mounted
PLC.

Horizontal

installation

Derate according to the actual ambient temperature on site, as shown in the

following figure.

● Input derating: Full load at 50℃, input points derated to 75% at 60℃ (namely＜27
points for models with 36 inputs or＜18 points for models with 24 inputs)
● Output derating: Full load at 50°C, output points derated to 75% at 60°C (namely＜
18 points for models with 24 outputs or＜12 points for models with 16 outputs)

Vertical

installation

Derate according to the actual ambient temperature on site, as shown in the

following figure.

● Input derating: Full load at 40℃, input points derated to 75% at 50℃ (＜ 27 points
for models with 36 inputs or ＜ 18 points for models with 24 inputs)
● Output derating: Full load at 40°C, output points derated to 75% at 50°C (namely＜
18 points for models with 24 outputs or＜12 points for models with 16 outputs)
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Type Item Input/output load derating curve

Parallel PLCs

(with

expansion

card)

● Parallel PLCs: With
expansion module and
two expansion cards
(not derated)
● Operating conditions:
CPU load rate of 80% or
below
● The installation
temperature for a
vertically-mounted PLC
is 10℃ lower than a
horizontally-mounted
PLC.

Horizontal

installation

Derate according to the actual ambient temperature on site, as shown in the

following figure.

● Input derating: Full load at 45℃, input points derated to 75% at 55℃ (＜ 27 points
for models with 36 inputs or ＜ 18 points for models with 24 inputs)
● Output derating: Full load at 45°C, output points derated to 75% at 55°C (namely＜
18 points for models with 24 outputs or＜12 points for models with 16 outputs)

Vertical

installation

Derate according to the actual ambient temperature on site, as shown in the

following figure.

● Input derating: Full load at 35℃, input points derated to 75% at 45℃ (＜ 27 points
for models with 36 inputs or ＜ 18 points for models with 24 inputs)
● Output derating: Full load at 35°C, output points derated to 75% at 45°C (namely＜
18 points for models with 24 outputs or＜12 points for models with 16 outputs)

Note
Up to eight GL20 modules are supported without a GL20-PS2 power supply and up to 15 GL20 modules can be ex-
panded with a GL20-PS2 power supply.

2.7 Components

Components of Easy321/Easy511 models

40-point/60-point models

The components are the same for all models. The following takes Easy511-3624TN models as an
example.
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No. Terminal type Symbol Assignment

① RS485 terminal ‑ For details, see “4.4.2 Terminal Assignment” on page 64.

② DI terminal ‑ For details, see “4.3.4.1 Terminal Assignment of 60-point
Model” on page 52 “4.3.4.2 Assignment of 40-point Model
Terminals” on page 56.

③ Input power supply
terminal

‑ For details, see “4.3.3 Assignment of Power Supply
Terminals” on page 51.

④ Signal indicator ‑ For details, see “7.2.2 Offline Diagnosis with Signal
Indicators” on page 81.

⑤ I/O indicator ‑ For details, see “7.2.2 Offline Diagnosis with Signal
Indicators” on page 81.

⑥ Output power
supply terminal

‑ For details, see “4.3.3 Assignment of Power Supply
Terminals” on page 51.

⑦ DO terminal ‑ For details, see “4.3.4.1 Terminal Assignment of 60-point
Model” on page 52 and “4.3.4.2 Assignment of 40-point
Model Terminals” on page 56.

⑧ Expansion card slot A/B Expansion card slot for function expansion (The GE21-EN card
is provided as standard in the card slot A of Easy511. For
details about expansion card options, see “9.3 Appendix 3:
Applicable Products” on page 99.)

⑨ Type-C interface Communication with PC

⑩ Network port - ● Easy511 model: EtherCAT interface, which can be
switched to Ethernet protocol
● Easy321 model: RJ45 interface for Ethernet
communication
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GE21-EN Ethernet card

The Easy511 series PLC is equipped with GE21-EN Ethernet card as standard by default. The
following table describes the components of the GE21-EN Ethernet card.

No. Terminal
type

Mark Assign
ment

Indicator
color

Note

①
Power
supply
indicator

PWR
Power
supply
OK

Yellow-
green

● Steady ON: Power supply OK
● OFF: Power supply not OK

②
Ethernet
LINK
indicator

LINK
Connec-
tion OK

Yellow-
green

● Steady ON: Connected
● OFF: Not connected

③
Ethernet
ACT
indicator

ACT
Commu-
nication
status

Yellow-
green

● Flashing: Communication in progress
● OFF: No communication in progress

④
User
terminal

- - -

RJ45 pin Signal description

1 TX+

2 TX-

3 RX+

4 -

5 -

6 RX-

7 -

8 -
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Note
The letter "A" in the figure indicates that only the card slot A of the PLC is supported.
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3 Installation

3.1 Installation Instructions

3.1.1 Introduction

Although this product has been designed based on strict standards, the following installation
requirements, such as installation method, installation space, and installation precautions, must still
be observed to ensure stable operation of the product.

3.1.2 Mounting Method

Mounting method

The drive can be installed horizontally or vertically. It is recommended to install the drive
horizontally. Different installation directions require different operating temperatures and limits. For
details, see “2.5 Environmental Specifications” on page 24.

● Face-up or face-down installation is not supported during horizontal installation.
● Observe the following requirements during vertical installation.

● The PLC must be installed below all I/O modules.
● Hold the cables with a cable duct to prevent the weight of cables being applied to the lower end plate,

which may result in loose of the PLC from the DIN rail, resulting in malfunction.

Heat dissipation requirements

This PLC dissipates heat by natural convection. To ensure proper ventilation and reserve sufficient
wiring space, keep a minimum clearance around the product. The following figure shows the
clearance ( (in mm) required for horizontal and vertical installation.
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Do not install the product directly above a heat-generating device (such as a heater, transformer, or large resis-
tor). Keep the product away from the heating source by at least 100 mm.

3.1.3 Installation Space

Installation dimensions

Dimensions of different models are consistent except the width. Detailed dimensions are shown
below (in mm).
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Model Width A/mm
Easy321-3624ER 205

Easy321-3624TP 205

Easy321-3624TN 205

Easy511-3624TN 205

Easy321-2416ER 155

Easy321-2416TP 155

Easy321-2416TN 155

Easy511-2416TN 155

Dimensions of the end cover is shown below (in mm).

Example for calculating the mounting width

The following takes one Easy321-2416ER + four GL20-0008ETN expansion modules + one end cover +
two end plates as an example (in mm). Total installation width = 155 mm + (12 x 4) mm + 4 mm + (8.5
x 2) mm = 224 mm

ECFA SRL - Av. San Juan 4063 (1233) - Buenos Aires - Argentina - Tel: +54 11 4923-6566 - email: ventas@ecfa.com.ar - www.ecfa.com.ar

https://www.ecfa.com.ar/
https://www.ecfa.com.ar/


Installation

‑34‑

The following shows the width of each expansion module (one model as an example) in mm.

Model Width/mm
GL20-0008ETN 12
GL20-0008ER 24
GL20-3232ETN 36
End plate 8.5

Space reserved for cables

When installing the product, reserve enough space for connecting cables, as shown in the following
figure (in mm).

3.1.4 Installation Precautions

To ensure the reliability and functional integrity of the product, observe the following
requirements when installing the product.

The installation environment of this product must meet the following requirements.

● Keep the product away from sunlight.
● Do not expose the product to conductive filaments or dust, including but not limited to carbon

fiber, gold bonding wire, and graphite powders, metal powder, and toner.
● Do not expose the product to contaminated liquids, including but not limited to water/oil mist,

cutting fluid, electroplating fluid, acid mist, hydrogen peroxide, detergent, and salt mist.
● Do not expose the product to corrosive gases, including but not limited to hydrogen sulfide,

sulfur dioxide flow, ammonia, chlorine, hydrogen chloride, and hydrogen fluoride.
● Do not expose the product to explosive gas or dust.
● Do not install the product on a device or machine with vibration source or shock source.
● Keep the product away from heat sources such as the heater.
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● Do not install the product in an environment with condensation or where the temperature
changes dramatically.

Take proper and adequate isolation measures when installing the product in the following
environments.

● Environments that affected by static electricity or other forms of noise
● Environments that affected by strong electromagnetic fields
● Environments that exposed to radiation
● Environments that close to the power supply cables or large AC drives, high-power high-

frequency generators, large contactors, and welding machines

Precautions when installing the product

● Before installing or removing the PLC and modules, ensure that they have been powered off.
● Do not hot swap the modules. This may lead to PLC restart, and user data loss or damage.
● To avoid damage to the PLC and modules, take measures to prevent the enclosure or terminals of

the PLC and modules from being dropped to subject to shocks.

3.2 Installation Preparation

Take an Easy321-2416ER PLC as an example. The following table shows the PLC, accessories, and
tools that needed for installation.
PLC, accessories,

and tools
Specification Quantity Diagram

PLC - 1

Expansion module - Several -

Expansion card - 1/2 -

DIN rail Compliant with IEC60715 standard
(35 mm in width and 1.0 mm in
thickness). For details, see “9.1
Appendix 1: Dimension
Diagram” on page 97.

1

End plate At least two end plates (a pair) to
be used together with the DIN rail

2

Screws (mounting
rail)

M4 Several -
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PLC, accessories,
and tools

Specification Quantity Diagram

Phillips
screwdriver

5 mm in radius 1

Slotted
screwdriver

2.5 mm to 3.0 mm in head width 1

3.3 Installation Process

3.3.1 Installing the Guide Rail

If the thickness of the DIN rail is not as required, the product cannot fit in or function properly as the DIN rail
mounting hook does not work.

Operation procedure

Tighten the screws on the DIN rail with a Phillips screwdriver. Secure with a M4 screws every 70 mm
or less along the rail at a tightening torque of 12 kgf·cm.

3.3.2 Installing the PLC

Operation procedure

1. Remove the end cover in the direction indicated by the arrow, as shown below.

2. Check that the DIN rail mounting hook is unlocked, as shown below.
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3. Align the PLC with the DIN rail and push it in the direction indicated by the arrow until you hear a
clicking sound, as shown below.

4. Make sure the DIN rail mounting hook of the PLC is locked. The locked and unlocked states of the
mounting hook are shown below.

● If the mounting hook is pressed down, it is locked.
● If the mounting hook is lifted up, it is unlocked. To lock the module to the DIN rail, press down

the mounting hook.

3.3.3 Installing the Expansion Card

For details on installation of each expansion card, see section 2.3 Installation Instructions in the
following user guides.

● GE21-CAN-485 Communication Expansion Card User Guide
● GE21-RTU Coupler Configuration Card User Guide
● GE21-TF-RTC Memory Expansion Card (Integrated with RTC) User Guide
● GE21-4AD1DA-I Analog Input and Output Current-Type Expansion Card User Guide
● GE21-8DI Digital Input Expansion Card User Guide
● GE21-8DO-TN Sink-Type Transistor Output Expansion Card User Guide
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● GE21-232 485-RTC Communication Expansion Card User Guide
● GE21-8DO-TP Source Transistor Output Expansion Card User Guide
● GE21-4AD1DA-V Analog Input and Output Voltage-Type Expansion Card User Guide

3.3.4 Installing the Expansion Module

1. Check that the DIN rail mounting hook of the expansion module is unlocked, as shown below.

2. Mate the expansion module with the guide rails at the top and bottom of the PLC and press the
module in the arrow direction until you hear a clicking sound, which indicates that the module has
been installed in place, as shown below.

3.3.5 Installing the End Cover

1. Align the end cover with the guide rail of the last expansion module and install it in the arrow
direction, as shown below.

2. Align the end cover with the end of the expansion module to prevent the metal pin from being
exposed, as shown below.
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3.3.6 Installing the End Plate

To mount the end plate, hook the bottom of it to the bottom of the DIN rail, rotate the end plate to
hook the top of the end plate to the top of the DIN rail, and then tighten the screws with a Phillips
screwdriver to lock the end plate in place, as shown below.

3.4 Post-installation Inspection

No. Item Compliance

① The rail mounting hook of the PLC and
expansion module are in the locked state.

② The end plates on both sides are securely
locked.

③ No unwanted objects are left on the
ventilation surfaces.

④ The installation environment meets the
environmental requirements.
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4 Wiring

4.1 Wiring Instructions

4.1.1 Introduction

The purpose of standard wiring practices in industrial environments is to reduce electromagnetic
interference (EMI) effects on equipment and systems, ensuring stable operation of industrial control
systems and the accuracy of data. Although Inovance has designed industrial products to meet
harsh environments, proper external wiring and cable routing may still be considered during use.

4.1.2 Basic EMC information

Electromagnetic interference sources exist only when the normal operation of sensitive devices is
affected. The three elements that constitute interference are interference sources, transmission
paths, and sensitive devices.

EMC problems root in the system. This chapter describes how to reduce the impact of interference in
the transmission path. Common solutions include shielding, isolation, and proper wiring.

Different coupling modes can be handled in different ways. The following describes the causes and
solutions of interference in several common coupling modes.

Common impedance coupling

● Cause: The grounding cable is used as one of the signal circuit paths. The impedance of the
grounding cable is about hundreds of nH/m. The voltage difference in the grounding cable
caused by interference on system A is superimposed to system B.

● Solution: Perform single-point grounding separately.
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Common power supply coupling

● Cause: Any change in the power supply current required by circuit 2 can affect circuit 1.
Interference of circuit 2 can easily disturb circuit 1.

● Solution:

■ Make sure that circuit 2 draws power directly from the power supply output terminal.
■ Use isolation transformers or filters.

Capacitive coupling

● Cause: Different signal cables are routed in parallel, with air being the medium, which can result
in capacitive coupling due to crosstalk.

● Solution: Shield the signal and increase the clearance between signal cables.
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Inductive coupling

1. Cause: When the variable current flows through the cable, a magnetic field can be generated
around the cable. The sensitive circuit in the magnetic field can generate an inductive voltage
current, which may affect the circuit.

2. Solution: Increase the clearance between cables to reduce mutual inductance and ground both
ends of the shielded cable.

4.1.3 Cable Routing Requirements

Routing requirements

● Routing of main circuit
The power supply input cable of the main circuit and motor cables can generate strong
electromagnetic interference. To avoid electromagnetic interference caused by long-distance
parallel routing between the disturbing cable and control circuit cables, keep a clearance of at
least 30 cm between main circuit cables and signal cables during routing. Main circuit cables
include the input R/S/T cables, output U/V/W cables, DC bus, and braking cables. Signal cables
include the I/O signal cables and communication cables. The spiral cable ducts must be in good
connection and well grounded. The aluminum cable duct ensures equipotential bonding of the
equipment. Both PLCs and I/O modules must be bonded properly with the system (mechanical
systems or devices). Apply protective coating to installation surfaces while maintaining full
contact with the conductive metal.

● I/O signals include analog input (AI) signals, analog output (AO) signals, digital input (DI)
signals, digital output (DO) signals, and relay output signals. To avoid interference to the I/O
signals, keep the I/O signal cables at least 30 cm away from the main circuit cables (R, S, and T
cables and U, V, and W cables) and other power cables or power supply cables.

Routing recommendations

● Routing disturbing cables and sensitive cables
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Route cables that transmit different types of signals through different routes. Separate the
disturbing cables from sensitive cables by a clearance of at least 30 cm. When these two types of
cables must be cross-connected, make sure that the cross-connection angle is 90 degrees to
prevent interference, as shown below.

● Routing cables that transmit different types of signals
Route cables that transmit different types of signals through different routes and separate
different types of signals with equipotential signals. When routing cables that transmit the same
type of signals, lay equipotential signal cables to the outer layer and lay equipotential bondings
as many as possible in the middle if possible, as shown in the following figure.

● Routing multi-conductor cables
For multi-conductor cables, it is recommended that one cable transmits one type of signals. If
one cable is used to transmit different types of signals, use the cable with conductors shielded,
as shown in the following figure.

Connect the spare or unused conductors in a multi-conductor cable to the equipotential
bondings, as shown below. Do not leave these conductors unconnected.
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● Avoiding separated wiring loop
For cables that transmit low-level sensor signals and common cables that transmit relay signals,
lay them close to each other to avoid a large loop area. Use twisted pair cables for analog
signals. Lay digital signal cables close to each other, as shown below.

● Laying multiple types of cables
For cables of different types, route the cables along the equipotential metal plate. To enhance
the internal EMC performance, separate different types of cables or separate cables with metal
separators (recommended) in the same metal (zinc‑iron or stainless steel) duct, as shown below.
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4.1.4 Grounding Requirements on Shielded Cables

Shielded cables can reduce interference in the magnetic, electric, or electromagnetic fields and
transfers the interference current from the shield to the ground.

Minimize the length of the unshielded part of a shielded cable, and connect the shield to the nearest
PE terminal. If the unshielded part is too long, the cable conductor is prone to signal interference.
For modules without dedicated PE terminal, connect the shield to an external PE terminal, as shown
below.
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4.1.5 Equipotential Grounding Requirements

Equipotential grounding connects the electrical equipment and external conductive parts to the
same potential. This not only prevents electric shock but also complies with EMC requirements.

● To ensure proper grounding of the product, observe the following requirements.

■ Ensure that the grounding terminal is properly grounded in accordance with the relevant
electrical regulations of the country or region, preventing improper operation or damage to
the equipment. The grounding terminal cannot be used as the neutral (N) terminal of the
power supply.

■ Ensure that the protective grounding conductor meets the technical specifications and local
safety standards. Keep the grounding cable as short as possible. The protective grounding
conductor must be made of yellow-green copper conductor and cannot be connected in
series with circuit breakers or other switching devices.

■ Observe the grounding requirements of all the devices as improper grounding can lead to
malfunction.

■ Install the device on a conductive metal surface. Ensure that the whole conductive bottom of
the device is in proper contact with the mounting surface.

■ Fasten the grounding screws with the recommended tightening torque.

● Grounding requirements for multiple devices
The following shows parallel grounding of multiple devices.

No. Wiring description

① Connect the main circuit input PE terminal to the grounding copper busbar of the control
cabinet through the protective grounding conductor.

② Connect the PE cable on the input power supply end to the grounding copper busbar of the
control cabinet.
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No. Wiring description

③ Connect the grounding copper busbar of the control cabinet to the metal enclosure of the
control cabinet through the protective grounding conductor.

④ Connect the motor output cable shield to the output PE terminal of the product.

● Grounding of the cabinet
To suppress interference in a cabinet properly, isolate the interference source from the disturbed
equipment during installation. Divide the cabinet into multiple EMC compartments or sub-
cabinets based on the intensity of the interference source, and install each device in accordance
with the following rules.

No. Grounding rules

① Install the control devices and drive devices into two separate cabinets.

② If multiple cabinets are used, use grounding cables with a cross-sectional area of at least 16
mm2 to connect different cabinets, therefore realizing equipotential bonding between the
cabinets.

③ Place the devices in different areas in the cabinet according to the device signal intensity.

④ Carry out equipotential bonding for the devices in different areas of the cabinet.

⑤ Shield all communication (for example, RS485) and signal cables that routed out from the
cabinet.

⑥ Install the power supply input filter close to the cabinet input interface.

⑦ Apply spray coating to all grounding points in the cabinet for protection.

4.1.6 Surge and Overvoltage Protection

The surge protection device (SPD) is installed on the input side of the PLC to ensure that electrical
systems and important electrical and electronic equipment are protected from damage caused by
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surge/overvoltage. The SPD is mainly used to limit transient overvoltage and operational
overvoltage caused by surge in power supply and signal systems. Lightning surges can be
transmitted to the PLC through the power supply or signal cable. When a lightning strike occurs, the
ground potential increases, which may damage the device. The induced voltage can be produced in
the cable and loop when a pulse electromagnetic field is generated by a lightning strike on the
building (or in the vicinity). Therefore, the SPD is a must in addition to external protective measures
such as surge protection pins, grounding cables, and grounding devices. External surge protection
measures cannot prevent conduction and secondary lightning strike along the lightning inductive
surge.

4.2 Connecting Ethernet or EtherCAT Network Cable

4.2.1 Wiring Precautions

Note the following when connecting the Ethernet/EtherCAT network cables.

● Use recommended cables and adapter boards for connection. It is recommended that shielded
cables be used as expansion cables to enhance the anti-interference capacity.

● When connecting the cable to the Ethernet/EtherCAT network port of the product, insert the cable
securely into the Ethernet/EtherCAT network port until it is locked in place.

● Route communication cables and power cables (high voltage cables or high current cables)
through different routes. Do not route communication cables in parallel with power cables.

● Do not place the communication cables near the noise-generating device. If this is unavoidable,
take measures to solve the noise problem, such as placing the device in a metal enclosure.

● Do not place the communication cable in environments with high temperature or high humidity.
● Do not place communication cables in environments with excessive dust, oil mist, or other

harmful elements.
● The bending radius of the communication cable is limited. Check the bending radius of the

communication cable.

4.2.2 Wiring Preparation

Cable requirements

The Ethernet/EtherCAT bus adopts standard RJ45 network port and standard registered jack. Use
shielded twisted pairs of Cat 5e or higher and injection cables with iron housing. Use shielded
network cable for network data transmission in Ethernet/EtherCAT bus communication. The
specifications for shielded network cables are shown in the following table.

Item Specification

Cable type Flexible crossover cable, S-FTP, Cat 5e and higher

Double-shielded Braided shield (coverage: 85%), aluminum foil shield (coverage: 100%)

Standards compliance EIA/TIA568A, EN50173, ISO/IEC11801

EIA/TI Abulletin TSB, EIA/TIA SB40-A&TSB36

Cross sectional area AWG26 and above
Conductor type Twisted pair
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Item Specification

Number of pairs 4

Certification UL
Environment ● Resistant to industrial oil, corrosive acid and alkali

● Ambient temperature: -30°C to +60°C

Note
The cable length between devices cannot exceed 100 m. Failure to comply can lead to signal attenuation, affect-
ing the communication performance.

Recommended cables

Recommended network cables are as follows.
No. Code Name Specifications

1 15040261 Complete cable set - S6-L-T04-0.3-100M network
communication cable - 0.3 m (RoHS)

CAT.5e SFTP 26AWG

2 15040262 Complete cable set - S6-L-T04-3.0-100M network
communication cable - 3 m (RoHS)

CAT.5e SFTP 26AWG

3 15041960 Complete cable set - S6-L-T04-0.2-100M network
communication cable - 0.2 m (RoHS)

CAT.5e SFTP 26AWG

4 15041961 Complete cable set - S6-L-T04-0.5-100M network
communication cable - 0.5 m (RoHS)

CAT.5e SFTP 26AWG

5 15041962 Complete cable set - S6-L-T04-1.0-100M network
communication cable - 1.0 m (RoHS)

CAT.5e SFTP 26AWG

6 15041963 Complete cable set - S6-L-T04 - 2.0m - 100M
network communication cable - 2.0 m (RoHS)

CAT.5e SFTP 26AWG

7 15041964 Complete cable set - S6-L-T04-5.0-100M network
communication cable - 5.0 m (RoHS)

CAT.5e SFTP 26AWG

8 15041965 Complete cable set - S6-L-T04-10.0-100M
network communication cable - 10.0 m (RoHS)

CAT.5e SFTP 26AWG

9 1504A819 Complete cable set - S6-L-T04-1.5-100M network
communication cable - 1.5 m (RoHS)

CAT.5e SFTP 26AWG

4.2.3 Pin Assignment

Ethernet/EtherCAT bus communication can be achieved through CN3 port. The following describes
requirements for the communication network cables.

Signal pin assignment

Pin No. Signal Signal Direction Signal description

1 TD+ Output Data transmission +
2 TD- Output Data transmission -
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Pin No. Signal Signal Direction Signal description

3 RD+ Input Data reception +

4 ‑ ‑ Not used
5 ‑ ‑ Not used
6 RD- Input Data reception -

7 ‑ ‑ Not used
8 ‑ ‑ Not used

4.2.4 Connecting/Disconnecting Cables

Connecting cables

Hold the registered jack with your finger and insert the network cable in the network port direction
until you hear a clicking sound, as shown below.

Disconnecting cables

To remove the network cable, press and hold the tail of the registered jack, and then pull it out
along the direction parallel with the network port.

4.3 Connecting Power Supply Cables and I/O Terminal Cables

4.3.1 Wiring Precautions

Note the following when connecting the power supply cables.

● Disconnect the external power supply before wiring.
● Route I/O terminal cables and high-voltage/high-current cables that can generate strong

interference through different and non-parallel routes.

4.3.2 Wiring Preparation

The following table shows the recommended cables, which can be calculated properly and adjusted
as needed. It is recommended to use a three-core non-shielded cable with a maximum length of 20
m. The total extension distance of the high-speed I/O interface extension cable must be lower than 3
m.
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Name

Applicable cross sectional
area

KST Suzhou Yuanli

GB standard/
mm²

US standard/
AWG

Model Crimping
tool

Model Crimping tool

Tubular lug

0.3 22 E0308

KST2000L

E0308

YAC-5
0.5 20 E0508 E0508
0.75 18 E7508 E7508
1 18 E1008 E1008
1.5 16 E1508 E1508

To use other types of tubular lugs, crimp the lug to the twisted pair according to the shape and
dimension requirements shown below.

Note
● Add crimping terminals to prevent short circuit of adjacent pins during terminal wiring.
● The maximum tightening torque for tightening wiring screws is 0.45 N·m.

4.3.3 Assignment of Power Supply Terminals

Model Terminal type Model Mark Silkscreen Description

40-point/
60-point
model

Input power
supply
terminal

ER

L Live line
N Neutral wire

Functional grounding terminal

TN, TP

+24V Connected to the power supply
+24VDC.

0V Connected to the power supply
0V.
Functional grounding terminal

Output power
supply
terminal

ER, TN, and
TP

+24V Connected to the power supply
+24VDC.

0V Connected to the power supply
0V.

/ -
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4.3.4 I/O Terminal Assignment

The following table describes the terminals of each model.

Termi
nal type

Model Description

I/O
termi-
nal

Easy321-3624ER 36 single-ended inputs, 8 of which support high-speed 200 kHz input; 24
outputs

Easy321-3624TN

Easy511-3624TN

Easy321-3624TP

36 single-ended inputs, 8 of which support high-speed 200 kHz input; 24
outputs, 8 of which support high-speed 200 kHz output

Easy321-2416ER 24 single-ended inputs, 8 of which support high-speed 200 kHz input; 16
outputs

Easy321-2416TN

Easy511-2416TN

Easy321-2416TP

24 single-ended inputs, 8 of which support high-speed 200 kHz input; 16
outputs, 8 of which support high-speed 200 kHz output

4.3.4.1 Terminal Assignment of 60-point Model

60-point ER model
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No. ① ② ③

Terminal type High-speed DI terminal Regular DI terminal Regular DO terminal

Product model Terminal signal Silkscreen Terminal signal Silkscreen Silkscreen Terminal signal

Easy321-3624ER

High-speed input

common terminal

SS0 Regular input

common terminal

SS1 COM0 Common

terminal 0

X00 input X00 X10 input X10 Y00 Y00 output

X01 input X01 X11 input X11 Y01 Y01 output

X02 input X02 X12 input X12 Y02 Y02 output

X03 input X03 X13 input X13 Y03 Y03 output

X04 input X04 X14 input X14 COM1 Common

terminal 1

X05 input X05 X15 input X15 Y04 Y04 output

X06 input X06 X16 input X16 Y05 Y05 output

X07 input X07 X17 input X17 Y06 Y06 output

‑ ‑ X20 input X20 Y07 Y07 output

‑ ‑ X21 input X21 COM2 Common

terminal 2

‑ ‑ X22 input X22 Y10 Y10 output

‑ ‑ X23 input X23 Y11 Y11 output

‑ ‑ X24 input X24 Y12 Y12 output

‑ ‑ X25 input X25 Y13 Y13 output

‑ ‑ X26 input X26 COM3 Common

terminal 3

‑ ‑ X27 input X27 Y14 Y14 output

‑ ‑ X30 input X30 Y15 Y15 output

‑ ‑ X31 input X31 Y16 Y16 output

‑ ‑ X32 input X32 Y17 Y17 output

‑ ‑ X33 input X33 COM4 Common

terminal 4

‑ ‑ X34 input X34 Y20 Y20 output

‑ ‑ X35 input X35 Y21 Y21 output

‑ ‑ X36 input X36 Y22 Y22 output

‑ ‑ X37 input X37 Y23 Y23 output

‑ ‑ X40 input X40 COM5 Common

terminal 5

‑ ‑ X41 input X41 Y24 Y24 output

‑ ‑ X42 input X42 Y25 Y25 output

‑ ‑ X43 input X43 Y26 Y26 output

‑ ‑ ‑ ‑ Y27 Y27 output
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60-point TN and TP models

Take the Easy321-3624TN model as an example.
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No. ① ② ③ ④

Terminal type High-speed DI terminal Regular DI terminal High-speed DO terminal Regular DO terminal

Product

model

Terminal

signal

Silkscreen Terminal

signal

Silkscreen Silkscreen Terminal signal Silkscreen Terminal

signal

Easy511-

3624TN

Easy321-

3624TN

Easy321-

3624TP

High-speed

input

common

terminal

SS0 Regular input

common

terminal

SS1 24V0 24 V input (+) 24V1 24 V input (+)

X00 input X00 X10 input X10 COM0 24 V input (-) COM1 24 V input (-)

X01 input X01 X11 input X11 Y00 Y00 output Y10 Y10 output

X02 input X02 X12 input X12 Y01 Y01 output Y11 Y11 output

X03 input X03 X13 input X13 Y02 Y02 output Y12 Y12 output

X04 input X04 X14 input X14 Y03 Y03 output Y13 Y13 output

X05 input X05 X15 input X15 Y04 Y04 output Y14 Y14 output

X06 input X06 X16 input X16 Y05 Y05 output Y15 Y15 output

X07 input X07 X17 input X17 Y06 Y06 output Y16 Y16 output

‑ ‑ X20 input X20 Y07 Y07 output Y17 Y17 output

‑ ‑ X21 input X21 ‑ ‑ 24V2 24 V input (+)

‑ ‑ X22 input X22 ‑ ‑ COM2 24 V input (-)

‑ ‑ X23 input X23 ‑ ‑ Y20 Y20 output

‑ ‑ X24 input X24 ‑ ‑ Y21 Y21 output

‑ ‑ X25 input X25 ‑ ‑ Y22 Y22 output

‑ ‑ X26 input X26 ‑ ‑ Y23 Y23 output

‑ ‑ X27 input X27 ‑ ‑ Y24 Y24 output

‑ ‑ X30 input X30 ‑ ‑ Y25 Y25 output

‑ ‑ X31 input X31 ‑ ‑ Y26 Y26 output

‑ ‑ X32 input X32 ‑ ‑ Y27 Y27 output

‑ ‑ X33 input X33 ‑ ‑ ‑ ‑

‑ ‑ X34 input X34 ‑ ‑ ‑ ‑

‑ ‑ X35 input X35 ‑ ‑ ‑ ‑

‑ ‑ X36 input X36 ‑ ‑ ‑ ‑

Easy511-

3624TN

Easy321-

3624TN

Easy321-

3624TP

‑ ‑ X37 input X37 ‑ ‑ ‑ ‑

‑ ‑ X40 input X40 ‑ ‑ ‑ ‑

‑ ‑ X41 input X41 ‑ ‑ ‑ ‑

‑ ‑ X42 input X42 ‑ ‑ ‑ ‑

‑ ‑ X43 input X43 ‑ ‑ ‑ ‑
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4.3.4.2 Assignment of 40-point Model Terminals

40-point ER model

No. ① ② ③

Terminal type High-speed DI terminal Regular DI terminal Regular DO terminal

Product model Terminal
signal

Silkscreen Terminal
signal

Silkscreen Silkscreen Terminal signal

Easy321-2416ER

High-speed
input common
terminal

SS0 Regular input
common
terminal

SS1 COM0 Common
terminal

X00 input X00 X10 input X10 Y00 Y00 output

X01 input X01 X11 input X11 Y01 Y01 output

X02 input X02 X12 input X12 Y02 Y02 output

X03 input X03 X13 input X13 Y03 Y03 output

X04 input X04 X14 input X14 COM1 Common
terminal

X05 input X05 X15 input X15 Y04 Y04 output

X06 input X06 X16 input X16 Y05 Y05 output

X07 input X07 X17 input X17 Y06 Y06 output

‑ ‑ X20 input X20 Y07 Y07 output

‑ ‑ X21 input X21 COM2 Common
terminal

‑ ‑ X22 input X22 Y10 Y10 output

‑ ‑ X23 input X23 Y11 Y11 output

‑ ‑ X24 input X24 Y12 Y12 output

‑ ‑ X25 input X25 Y13 Y13 output

‑ ‑ X26 input X26 COM3 Common
terminal

‑ ‑ X27 input X27 Y14 Y14 output

‑ ‑ ‑ ‑ Y15 Y15 output
‑ ‑ ‑ ‑ Y16 Y16 output
‑ ‑ ‑ ‑ Y17 Y17 output
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40-point TN and TP models

Take the Easy321-2416TN model as an example.
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No. ① ② ③ ④

Terminal
type

High-speed DI
terminal

Regular DI terminal High-speed DO terminal Regular DO terminal

Product
model

Terminal
signal

Silk
screen

Terminal
signal

Silk
screen

Silk
screen

Terminal
signal

Silk
screen

Terminal
signal

Easy321-
2416TN

Easy321-
2416TP

Easy511-
2416TN

High-
speed
input
common
terminal

SS0 Regular
input
common
terminal

SS1 24V0 24 V input (+) 24V1 24 V input
(+)

X00 input X00 X10 input X10 COM0 24 V input (-) COM1 24 V input
(-)

X01 input X01 X11 input X11 Y00 Y00 output Y10 Y10
output

X02 input X02 X12 input X12 Y01 Y01 output Y11 Y11
output

X03 input X03 X13 input X13 Y02 Y02 output Y12 Y12
output

X04 input X04 X14 input X14 Y03 Y03 output Y13 Y13
output

X05 input X05 X15 input X15 Y04 Y04 output Y14 Y14
output

X06 input X06 X16 input X16 Y05 Y05 output Y15 Y15
output

X07 input X07 X17 input X17 Y06 Y06 output Y16 Y16
output

‑ ‑ X20 input X20 Y07 Y07 output Y17 Y17
output

‑ ‑ X21 input X21 ‑ ‑ ‑ ‑

‑ ‑ X22 input X22 ‑ ‑ ‑ ‑

‑ ‑ X23 input X23 ‑ ‑ ‑ ‑

‑ ‑ X24 input X24 ‑ ‑ ‑ ‑

‑ ‑ X25 input X25 ‑ ‑ ‑ ‑

‑ ‑ X26 input X26 ‑ ‑ ‑ ‑

‑ ‑ X27 input X27 ‑ ‑ ‑ ‑

4.3.5 Terminal Wiring

Wiring block diagram of terminal input

● For the wiring block diagram of relay input, see that for the sink input and source input.
● Sink input
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● Source input

ECFA SRL - Av. San Juan 4063 (1233) - Buenos Aires - Argentina - Tel: +54 11 4923-6566 - email: ventas@ecfa.com.ar - www.ecfa.com.ar

https://www.ecfa.com.ar/
https://www.ecfa.com.ar/


Wiring

‑60‑

Wiring block diagram for terminal output

● Relay

● Sink

● Source
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● Electric shock protection for use of inductive load
The PLC is not equipped with an internal protection circuit for relays. Therefore, when an
inductive load is used, a large back EMF can be generated between contacts at stop, which can
lead to arc discharge that causes contact failure or contact pitting, shortening the service life of
the contacts. It is recommended to use loads with built-in protection circuit.

For loads without built-in relay protection circuit, you can use an external electric shock
protection circuit to reduce noise and prolong the service life.

■ Relay DC circuit
Connect a freewheeling diode in parallel with the load upon DC circuit. The freewheeling
diode must satisfy the following requirements: ① reverse voltage: 5 to 10 x load voltage; ②
forward current ＞load current.

■ Relay AC Circuit
Connect a surge protection device in parallel with the load. The surge protection device must
meet the following requirements: ① The rated voltage is applicable to all kinds of outputs; ②
The electrostatic capacity is about 0.1 μF; ③ The resistance is about 100 Ω to 200 Ω.

● Electric shock protection when using capacitive load
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When a capacitive load is applied, an impulse current, 20 to 40 x regular current, can occur in the
case of electric shock. Note that the impulse current cannot exceed the current generated upon
the maximum resistive load.

For electronic circuit loads such as AC drives, capacitive loads may exist as the AC drive contains
capacitors.

Input/Output wiring diagram

The following takes 60-point ER/TN/TP models as an example, which is similar to the 40-point ER/
TN/TP models.

● Relay output

● Sink output

● Source output
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4.3.6 Connecting/Disconnecting Cables

Connecting cables

1. Insert the cable into the terminal.
2. Tighten the screws with a slotted screwdriver to secure the cables, as shown below.

Disconnecting cables

Loosen the terminal screws with a slotted screwdriver and pull out the cable.
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4.4 Connecting RS485 Cables

4.4.1 Wiring Preparation

For details, see “4.3.1 Wiring Precautions” on page 50.

4.4.2 Terminal Assignment

Terminal type Model Network silkscreen name Description

RS485 terminal ER, TN, and TP

485+ RS485 communication signal +

485‑ RS485 communication signal -

GND [1] 485 GND

[1] Do not connect a grounding cable to GND.

4.4.3 Terminal Wiring

The following figure shows the RS485 bus connection topology. Note the following when connecting
the RS485 bus.

● It is recommended to use shielded twisted pair cables for connecting the RS485 bus. Connect 485
+ and 485- with twisted pairs [1].

● To prevent signal reflection, connect a 120 Ω termination resistor[2] at each end of the bus.
● Connect the reference grounds of 485 signals of all the nodes together.
● A maximum of 31 nodes can be connected, and the distance between the node branches must be

shorter than 3 m.

Ω

Note
[1] Add crimping terminals to prevent possible short circuit of adjacent pins during terminal wiring.

[2] The Easy series PLC is not equipped with a termination resistor. You can connect an external termination resis-
tor as needed. The GE21-CAN-485 expansion card is equipped with a termination resistor, which can be con-
trolled through a DIP switch. This DIP switch is set to ON (termination resistor applied) by default.

4.4.4 Connecting/Disconnecting Cables

For details, see “4.3.6 Connecting/Disconnecting Cables” on page 63.
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4.5 Connecting the USB Cable

4.5.1 Wiring Preparation

Prepare an USB cable and a PC.

4.5.2 Connecting/Disconnecting Cables

Connecting cables

Connect one end of the USB cable to the Type-C terminal of the PLC and the other end to the PC.

Note
To remove the cable, pull out the USB cable directly.
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5 Configuration and Commissioning

5.1 Configuration

The following takes configuration of Easy511-3624TN+GL20-RTU-ECT32+GL20-1600END+GL20-
0016ETN as an example to present configuration and commissioning of Easy511 series PLC.

Prerequisites

● The hardware installation and wiring in the configuration example is done.
● All the devices in the configuration example are powered on and started.
● The PC with the AutoShop programming software is connected to Easy511 series PLC through an

USB cable.

Operation procedure

1. Create a project.

a. Double-click the AutoShop shortcut icon on the PC desktop to open the AutoShop programming
software.

b. Select "File > New Project" in the menu bar to open the "New Project" dialog box, as shown
below.

c. Set the project name, project path, programming language, and project description. Select
"Easy500 - Easy511-3624TN" in "Series and Model", and click "OK" to enter the Easy511-3624TN
project interface.
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2. Add a coupler.
Select "EtherCAT Devices > Inovance Devices > I/O coupler" on the "Toolbox" interface, and
double-click "GL20-RTU-ECT32". In the project management tree, generate a "GL20-RTU-ECT32"
slave node under the "EtherCAT" node, and open the configuration interface as shown below.

3. Add an expansion module.

● Method 1: Adding manually

a. Click "Slot Configuration" to enter the corresponding interface.
b. Select the module on the right side of the interface, click "Add/Change" to add the GL20
series expansion module. GL20-1600END and GL20-0016ETN modules are taken as example.
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Note
● When the sum of the power consumption of the module added exceeds the maximum power consumption, a

pop-up prompt can be displayed.
● To delete a module, select the module on the left side of the interface and click "Delete".

● Method 2: Scanning automatically

a. Right-click "EtherCAT" in the project management tree and select "Auto Scan".

b. Click "Start Scan" in the dialog box that opens to display GL20 series expansion modules
actually mounted.
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Note
When the total power consumption of the scanned modules exceeds the maximum power consumption, the con-
figuration can be updated normally, but an alarm message can be displayed during compilation.

c. Click "Update Config". The EtherCAT configuration in the project management window is
shown in the following figure.

4. Configure the module.
Double-click the module node in the project management tree under "EtherCAT>GL20-RTU-ECT32"
in sequence to open the configuration interface of the corresponding module and configure the
module parameters. The module parameters are described in the following table.
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Module Name Description Setting

GL20-
1600END

Filter parameter Input filter time Drop-down options: No filter, 0.25
ms, 0.5 ms, 1 ms.2 ms, 4 ms, 8 ms,
16 ms, 32 ms, 64 ms, 128 ms

Default: 1 ms
GL20-
0016ETN

Network cut-
off/Output
stop mode

Retained/
Settings

Retained: Keep present
output status

Settings: Output
according to preset value

Click the radio button before
"Retained"/"Settings".

ON/OFF Output preset value:

● ON: Output 1
● OFF: Output 0

Click the radio box in the front of
"ON"/"OFF".

5. Download, run, and stop the program.

a. Click the download button in the toolbar to download the program to the PLC.
b. After download, click the operation button in the toolbar to run the program.

6. Click the monitor button in the toolbar. Green icons are displayed in front of the EtherCAT node
and GL20-RTU-ECT32 node. The "Current status of PLC" indicator and "Failure status" indicator at
the bottom of the AutoShop interface are displayed in green, indicating that no error is reported
by the PLC, which means the GL20-RTU-ECT32 communication interface module is operating
properly.
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5.2 Commissioning

After the Easy series PLC is configured with the remote I/O, you need to perform simple
commissioning on the remote I/O functions to ensure that the PLC, EtherCAT coupler, and GL20
expansion module operate properly. In this section, the delay time for "Output > Input" is tested by
taking the two terminals of remote I/O as an example.

Prerequisites

After I/O wiring is done, connect the 00 terminal output of GL20-0016ETN to the 00 terminal input of
GL20-1600END.

Operation procedure

1. Perform I/O mapping.

a. Double-click the "Config > EtherCAT > GL20-RTU-ECT32" in the project tree to open the
configuration interface of the EtherCAT coupler. Click "I/O Functional Mapping" in the
configuration interface. You can see GL20-0016ETN and GL20-1600END expansion modules that
added in “5.1 Configuration” on page 66 in the "Channel" bar, as shown below.
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b. The remote I/O terminal mapping consists of 8 bits as a group to form a channel. Double-click
the icon in "GL20-0016ETN_1 Digital output CH0-8bit" channel. Open the "Variable Input
Assistant" window, click "SoftElement > WordElement > D(0-7999)", and select the D0 soft
component. Click "OK" to done the 8-bit mapping of channel 0.

Map input channel 0 to D2 soft component in the same procedure. The following figure shows
the interface after mapping is done.
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2. Write a test program.
The following figure takes ladder diagram programming in the MAIN program block as an
example.

● Network 1
"_ECATMaster" is a predefined system structure variable, which can be viewed by double-
clicking "System Variable Table > _SYS_ECAT_MASTER" in the project management tree. Click
the "_ECATMaster" variable name in the system variable table "_SYS_ECAT_MASTER" to view the
details of the structure variable in the "Toolbox" window on the right side of the interface, as
shown in the following figure. The member "bMasterRunState" indicates whether EtherCAT has
been initialized.
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Note
● The remote I/O in this example is based on EtherCAT. Therefore, EtherCAT initialization must be done before

output.
● D0.0 indicates the lowest bit of the word soft component of D0. In step 1 "I/O mapping", the low 8 bits of D0

are bound to the first 8 channels of the remote output terminal. Therefore, setting D0.0 is equivalent to
generating output from terminal 00 of GL20-0016ETN.

● Network 2
When D0.0 generates output, start a TONR switch-on delay timer for timing. Note that only the
timing function is used here, and the "delayed switch-on" feature is not used. The TONR.PT is
set to 1000 ms only to prevent the timing from ending before the purpose of this example is
achieved. TONR.ET indicates the time elapsed from the moment when TONR.IN is set to the
moment when the time is counted to TONR.PT. For details on the use of the TONR instruction,
see H5U&Easy Series Programmable Logic Controller Instruction Guide.

● Network 3
The GL20-1600END terminal 00 that bound to D2.0 is the input in this example. When D2.0
receives the D0.0 signal, a rising edge is generated to trigger the MyRisingTrigger.CLK pin,
which in turn sets the MyRisingTrigger.Q pin to a main task scan cycle.

● Network 4
Save the time in network 2 TONR.ET to D200 during the current scan cycle that set by the
MyRisingTrigger.Q pin. After power-on, the value saved in D200 is the delay time of the remote
I/O "Output > Input" in this example.

3. View the results.
To get consistent results, set the main task scan cycle to 1 ms and the EtherCAT scan cycle to 1 ms.

a. Set the main task scan cycle.
Right-click "Program Block" and click "Block Properties".

In the dialog box that opens, check "Constant scan period" and fill in a value of 1 ms.

b. Set the EtherCAT scan cycle.

1). Double-click "Config > EtherCAT" to open the EtherCAT configuration interface. Set the Cycle
time option in "General Settings > Distributed clock" to 1000 μs.
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2). Click on the toolbar to download the program and configuration to the PLC.

3). Click on the toolbar to monitor the PLC and view the results in the MAIN, as shown in the
following figure.

This result is for reference only, which varies with programs and firmware versions. For detailed I/O refresh per-
formance, see H5U&Easy Series Programmable Logic Controller Programming Guide.
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6 Product Functions

6.1 PN Coupler Mode

Function description

The GE21-RTU expansion card allows you to quickly configure the PLC as a PN coupler. The
expansion card can be used to back up the configuration information of the PLC that used as a PN
coupler. After replacing the PLC, the parameters are automatically downloaded for direct operation,
allowing software-free maintenance.

Models supported

The GE21-RTU expansion card supports all Easy321 models.

PN coupler mode switchover

For detailed configuration of PN coupler mode, see section Configuration and Commissioning in
GE21-RTU Coupler Configuration Card User Guide.

● The GE21-RTU expansion card only supports EXP-B card slot.
● The type ID of the GE21-RTU expansion card is 18. The configured expansion card type must be consistent with

the type of the expansion card installed.

● Switching to PN coupler mode with GE21-RTU expansion card

■ Group S2: 1

—— DIP switch 0: Allows the expansion card to upload backup data to the PLC.
—— DIP switch 1: Allows backup data to be downloaded from PLC to the expansion card.

■ Groups S2: 2 to 4

—— DIP switch 010: Indicates the PN coupler mode.
—— Other DIP switches: Indicate the PLC mode.

■ Other DIP switches are not enabled.

● Switching to PN coupler mode with AutoShop
Operation procedure

1. Create a new project in AutoShop, click the RTU button in the toolbar, and click "Yes" in the
pop-up window.
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2. A window that indicates setting is done successfully pops out. Click "OK" in this window to
allow the coupler mode to be activated at next power-on.

3. The current mode is coupler mode.

● Reserving PLC function in the PN coupler mode
When switching to the coupler mode, the PLC cannot enter the operational state and only the
following PLC functions are supported.

■ Firmware upgrade: The operation mode does not change upon firmware upgrade/
downgrade. For SD cards and IMG, the PLC mode applies upon firmware upgrade.

■ Project upload/download: After the project is downloaded, the PLC cannot run and the
software tool indicates "Operation cannot be switched in the coupler mode".

■ Online monitoring: Only I/O status can be monitored. The PLC program cannot run or be
modified online.
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■ Modifying the network port IP: The IP is activated immediately after modification.

6.2 Dual Network Ports

Function description

The PLC carries a built-in EtherCAT port. The GE21-EN expansion card provides an additional
network port.

● The built-in Ethernet port supports one EtherCAT channel, which can be switched to Ethernet
protocol.

■ The local network port of Easy511 series PLC is EtherCAT by default, as shown in the figure.

■ When the local network port is Ethernet, you can switch to the EtherCAT mode by right-clicking
"Project > Ethernet 0 > Switch to EtherCAT".
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● The built-in GE21-EN expansion card provides one expansion network port to support functions
including Ethernet-based monitoring, program upload/download, Socket, Modbus-TCP, and EIP.

Models supported

The Easy511 series PLC is equipped with a GE21-EN Ethernet card as standard.

6.3 Expansion of Local I/O Points

Function description

The Easy 321 and Easy511 series PLCs have relay output models.

● Short circuit protection function for transistor model
Each of the eight output terminals form a group that shares short circuit protection. Take Y10 to
Y17 as an example. If Y12 is short-circuited, the short circuit protection is triggered and Y12
cannot be operated. You can view the short circuit alarm with fault code 5302 through the
software tool. After the short circuit fault is cleared, power on the 24 V external power supply
next to terminals Y10 to Y17 again to restore the function of Y12.

● Output action counting function for relay model
You can record the number of actions during the lifetime of the relay model. Double-click
"System Variable Table > _SYS_INFO" in the project management tree, and click "_RelayCntDisp"
to view the member variables in the tool box on the right, as shown in the following figure.
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7 Fault Diagnosis

7.1 Overview of Fault Diagnosis

For more information, see section "Fault Diagnosis" in H5U&Easy Series Programmable Logic
Controller Programming Guide.

Fault diagnosis serves to help users quickly locate the cause of operation deviation and find
solutions based on the fault prompts. The PLC is integrated with the fault diagnosis function. When a
fault occurs, you can see the detailed diagnosis information through hardware indicators and fault
diagnosis window of the host controller programming software.

This chapter describes the fault diagnosis function in the following aspects: fault diagnosis
methods, fault diagnosis cases, fault classification, and fault codes.

7.2 Fault Diagnosis Method

7.2.1 Introduction

The diagnostic information can be obtained through offline diagnosis with PLC signal indicators and
online diagnosis with AutoShop software.

7.2.2 Offline Diagnosis with Signal Indicators

When the product is running in an operating environment and is not connected to AutoShop, you
can determine the PLC status offline through the signal indicator on the product panel.
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The following table describes the signal indicator definitions, status, and solutions.

Terminal type Mark Color Description Solution

Signal

indica

tor

Power-on

status

indicator

PWR Yellow-

green

● Steady ON: Power supply OK
● OFF: Power supply error

Used to check whether the power supply is normal.

Operation

status

indicator

RUN Yellow-

green

● Steady ON: User program is
running
● OFF: User program stopped

Used to check whether the PLC operates properly.

PLC system

status

indicators

ERR Red ● OFF: No critical error
● Flashing: The PLC is faulty and
stops running.

If the ERR indicator flashes, use AutoShop online

diagnosis to check the cause of the PLC error. For

details, see “7.2.3 Online Diagnosis with
AutoShop” on page 83.

Network port

status

indicator

LINK Yellow-

green

● Steady ON: Network connected
successfully
● OFF: Network not connected

Used to check whether the network port is connected

properly.

Network port

status

indicator

ACT Yellow-

green

● Flashing: Data transmission in
progress on the built-in network
port
● Steady ON: No data transmission
on the built-in network port

Used to check whether data transmission of the

network port is normal.

I/O indicator

IN Yellow-

green

● Steady ON: Signal input generated
by the terminal
● OFF: No signal input generated
from the terminal

Used to check whether the input terminal is active. If

not, check whether the input common terminal is

wired properly.

OUT Yellow-

green

● Steady ON: Signal output
generated by the terminal
● OFF: No signal output generate
from the terminal

Used to check whether the output terminal is active.

If not, check whether the common output terminal is

wired properly.

Transistor models with a large number of points are

equipped with the output short circuit protection

function. When the indicator turns on but no output

is generated, check whether the output terminal is

short-circuited. After the short circuit fault is

rectified, the terminal function can be restored after

the 24 V power supply of the output terminal is

powered on again.
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Note
To restart the product upon a fault, turn off the power supply and disconnect the USB power supply cable, and
wait for at least 10s before power on again.

7.2.3 Online Diagnosis with AutoShop

The integrated fault diagnosis function allows you to view the fault source, fault details, and
recommended solutions through AutoShop. This chapter describes how to use the diagnosis
function of AutoShop.

Prerequisites

● The PLC has been connected to the PC that installed with AutoShop through a network cable or
USB cable.

● The PLC has been powered on and started.

Operation procedure

1. Open the AutoShop fault diagnosis window. There are two ways to open the fault diagnosis
window:

● Method 1: Select "Debug > Fault Diagnosis" in the menu bar at the top of the AutoShop
interface.

● Method 2: Click the monitoring button in the AutoShop toolbar to enter the monitoring
mode. The "Current status of PLC" and "Failure status" indicators locate at the bottom of the
AutoShop interface.
Double-click the fault indicator to open the fault diagnosis window. No fault occurs at this
moment.

2. Perform fault diagnosis.
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● You can filter the display of fault entries based on the device type through area ①.
● You can view the fault level, serial number, time, fault code, fault information, fault device

type, and fault location through area ②.

■ There are two fault levels. One is critical fault that displayed in red triangle . Critical
faults can cause the PLC to stop. The other is minor fault that displayed in yellow triangle

. Minor faults do not cause the PLC to stop but need to be paid attention to.
■ Fault code is the unique number of a fault. For detailed fault codes, see section Fault codes

in H5U&Easy Series Programmable Logic Controller Programming Guide.
■ The fault information indicates the fault cause.
■ The device type indicates the fault source.
■ You can locate the fault through "Goto Error" on the lower right corner of the fault diagnosis

window.

● You can click on a specific fault entry to display the fault details and recommended solutions
through area ③.

7.3 Fault Diagnosis Cases

The following takes the fault in “7.2.3 Online Diagnosis with AutoShop” on page 83 as an example for
fault diagnosis.

Prerequisites

● Watchdog time: 100 ms; fixed scanning cycle: 1 ms; 8-bit FOR loop written in the subprogram to
make a watchdog timeout fault intentionally

● The module is configured with GL20-0808ETN, but the GL20-0808ETN module is not mounted
actually.

● Make the Y0 terminal generate output through the program to short circuit the terminal
intentionally.

Troubleshooting procedure
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1. Perform offline diagnosis through the signal indicator. The RUN indicator on the PLC panel is off
and the ERR indicator flashes in red, which indicates the PLC stops due to a fault.

2. Perform online diagnosis through AutoShop to determine the fault cause. Use AutoShop to
monitor the PLC and open the fault diagnosis page.

● The entry 1 indicates that the error is caused by a watchdog timeout fault of the user program.
Increase the watchdog time or check whether the program has sections with excessive
execution time.

● The entry 2 indicates that the program loop is not responding in a long time. Click entry 2 to
locate the 8-digit FOR loop that causes the watchdog timeout fault. In this case, you can
optimize the program or increase the watchdog time as needed.

● The entry 3 indicates that short circuit exits in Y00 to Y07 terminals. Check the wiring to rectify
the fault.
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● The entry 4 indicates that the expansion module is not installed, but the user may have
configured the expansion module.

You can find and rectify this fault by viewing the "Project Management" window in the
monitoring state.
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7.4 Fault Classification and Fault Codes

For a complete list of fault codes, see H5U&Easy Series Programmable Logic Controller Programming
Guide.

The following table lists the newly added fault codes.

● CPU fault codes

Fault
code

Fault message Meaning Solution

3010 After switching to
ECT or ETH drive
through the
software, perform a
restart to activate
the switchover.

The ECT or ETH drive
configured through the
software does not match the
drive actually operated by the
board, resulting in PLC
operation failure.

Power off and restart to activate the drive
and run the PLC.

5902 Check whether
network segment
conflict exists
between the
network ports of the
device. If a network
segment conflict is
detected, the local
network port will be
closed. Modify the
network segment of
the local network
port.

The network segment is in
conflict with others.

Modify the network segment of the local
network port.
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● Local I/O fault codes

Fault
code

Fault message Meaning Solution

5302 The Yxx to Yzz
terminals are short-
circuited.

The Yxx to Yzz terminals are
short-circuited.

Check the wiring of Yxx to Yzz terminals.
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8 Maintenance

8.1 Cleaning and Routine Maintenance

8.1.1 Cleaning

Before cleaning, ensure that the power supply has been switched off. Do not use volatile solvents such as paint
thinner, benzene, or chemical wipes for cleaning.

Clean the dirt with a piece of soft dry cloth during routine cleaning. For stubborn dirts that cannot be
removed with the soft dry cloth, use a piece of cloth moistened with properly diluted cleaning agent
(2% concentration), ensuring thorough wringing to achieve damp (not wet) condition prior to
wiping.

8.1.2 Routine Maintenance

Tools needed

● Multimeter: Used to measure the voltage.
● Thermometer: Used to measure the temperature.
● Humidity meter: Used to measure the humidity.
● ESD cleaning cloth: Used to wipe dust or dirt.
● Phillips screwdriver: Used to tighten the screws and replace the battery.
● Slotted screwdriver: Used for wiring and terminal assembly/disassembly.

Routine maintenance items
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Item Description Criteria Solution

Power

supply

Measure the voltage through the

power terminal block to check

whether the voltage variation is

within the allowable range.

● Transistor type: 24 VDC input; voltage
range: 21.6 VDC to 26.4 VDC
● Relay type: 220 VAC input; voltage range:
85 VAC to 264 VAC
● Analog type:● Voltage input range: ±10 V, 0
V to 10 V, ±5 V, 0 V to 5 V, and 1 V to 5 V●

Current input range: ±20 mA, 0 mA to 20 mA,
and 4 mA to 20 mA

Measure the voltage between terminals

using a multimeter and keep the voltage

variation within the allowable range.

Check whether the power supply

is also used by other devices.

The power of the power supply is higher than

the power of all devices.

When multiple devices share the same

power supply, oscillation may occur upon

power-on due to insufficient power. It is

recommended to use a separate power

supply.

Environment

inspection

Check for corrosive gas and

flammable gas.

Not allowed If corrosive gas or flammable gas exists,

take counter measures.

Check whether the ambient

temperature is proper (When the

PLC is installed in a cabinet, the

temperature within the cabinet is

the ambient temperature).

● Temperature:
Single PLC: -20°C to +60°C
Parallel PLCs: -20°C to +55°C
● Humidity: < 95% RH (30℃), without
condensation

If the specified temperature range and

humidity are exceeded, take counter

measures.

Check for direct sunlight. Not allowed Take protective measure against the

sunlight.

Check for dust, dirt, salt, and iron

filings.

Not allowed Perform comprehensive cleaning and take

protective measures.

Check for droplets that stained

with water, oil, or chemicals.

Not allowed Perform comprehensive cleaning and take

protective measures.

Check for vibration or shock to the

PLC.

The vibration or shock to the PLC must be

within the specified range.

Use cushioning materials for vibration and

shock resistance.

Check for interference. Not allowed Keep the PLC away from interference

sources or take shielding measures.

Check the

installation

and wiring.

Check whether cable connectors

are fully inserted and locked.

Avoid loose connection. Fully insert the connector and lock it with

screws.

Check whether crimping terminals

used for external wiring locate

closely to each other.

Keep a proper clearance between crimping

terminals.

Check the clearance visually and rectify

improper clearance.

Check whether the external wiring

screws are securely fastened.

Avoid loose connection. Use a Phillips screwdriver to tighten the

screws.

Check whether external cables are

broken.

The surface of external cables should be

intact.

Check cables visually and replace broken

cables (if any).

Check whether the PLC rail lock is

securely fastened to the DIN rail.

The PLC and guide rail are installed securely. Connect the PLC to the DIN rail securely.
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Item Description Criteria Solution

Check the PE

grounding

and shield.

Check whether the PE is grounded

securely.

Screws at the PE grounding point are

connected securely.

Tighten the screws at the PE grounding

points are connected securely.

Check whether the conductor

layer of the PE grounding cable is

damaged.

Not allowed Replace the PE grounding cable.

Check whether the PE grounding

point is rusted or oxidized.

The PE grounding point is free from rust or

oxidation.

Remove rust and oxidation deposits from

the PE grounding point.

Check whether the shield of the

shielded cable is damaged,

corroded, or oxidized.

Not allowed Replace the shielded cable.

Check whether the shield of the

shielded cable is bonded

properly.

The shield of the shielded cable is bonded

properly.

Bond the shield of the shielded cable

properly.

8.2 Parts Replacement

8.2.1 Replacing the PLC

Prerequisites

● The PLC has been powered off.
● Prepare a slotted screwdriver or similar tool.

Operation procedure

1. Use a slotted screwdriver or similar tool to pry up the DIN rail mounting hook to remove the old
module, as shown below.

2. Pull the old module away from the rail, as shown below.
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3. Install a new PLC, as shown in “3.3.2 Installing the PLC” on page 36.

8.2.2 Replacing the Expansion Card

For details on replacing the expansion card, see section 2.3 Installation Instructions in the following
user guides.

● GE21-CAN-485 Communication Expansion Card User Guide/GE21-RTU Coupler Configuration Card
User Guide

● GE21-TF-RTC Memory Expansion Card (Integrated with RTC) User Guide
● GE21-4AD1DA-I Analog Input and Output Current-Type Expansion Card User Guide
● GE21-8DI Digital Input Expansion Card User Guide
● GE21-8DO-TN Sink Transistor Output Expansion Card User Guide
● GE21-232 485-RTC Communication Expansion Card User Guide
● GE21-8DO-TP Source Transistor Output Expansion Card User Guide
● GE21-4AD1DA-V Analog Input and Output Voltage-Type Expansion Card User Guide

8.2.3 Replacing the Expansion Module

Prerequisites

● The module has been powered off.
● Prepare a slotted screwdriver or similar tool.

Operation procedure

1. Use a slotted screwdriver or similar tool to pry up the DIN rail mounting hook to remove the old
module, as shown below.
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2. Pull the old module away from the rail, as shown below.

3. Install a new module, as shown in “3.3.4 Installing the Expansion Module” on page 38.

8.2.4 Replacing the Terminal

Prerequisites

● The PLC has been powered off.
● Prepare a slotted screwdriver or similar tool.

Operation procedure

1. Insert a slotted screwdriver down into the slot.

2. Gently pry up the old power supply terminal to separate it from the PLC, as shown below.
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3. Insert the new power supply terminal properly.

8.2.5 Replacing the Spare Battery

For details, see "GE21-TF-RTC Memory Expansion Card (Integrated with RTC) User Guide".

8.3 Software Maintenance

8.3.1 Programming the Micro SD Card Firmware

Prerequisites

● Prepare a Micro SD card with file system FAT32 and capacity lower than or equal to 32 G.
● Power off the PLC.

Note

The original applications are deleted after the firmware is done programming.
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Operation procedure

1. Load the Micro SD card to the GE21-TF-RTC expansion card and mount the GE21-TF-RTC expansion
card to the PLC.

2. Power on the PLC again.

a. The RUN indicator and ERR indicator on the PLC flash for three seconds, indicating that firmware
programming starts.

b. When the RUN and ERR indicators are steady ON, the firmware is being programmed.
c. When the RUN and ERR indicators start flashing slowly, the firmware is done programming.

3. After firmware programming is done, power off the PLC and remove the GE21-TF-RTC expansion
card.

4. Power on the PLC again.

8.3.2 Downloading User Program from Micro SD Card

Prerequisites

● Prepare a Micro SD card with file system FAT32 and capacity lower than or equal to 32 G.
● Power off the PLC.

Operation procedure

1. Generate a "Down/Updown" file using AutoShop. For details, see H5U and Easy Series
Programmable Logic Controllers Programming and Application Guide.

2. Create a "PLCProgram" directory in the root directory of the Micro SD card and copy the "Down/
Updown" file to the "PLCProgram" directory.

3. Load the Micro SD card to the GE21-TF-RTC expansion card and install the expansion card to the
PLC.

4. Power on the PLC again and download the user program in the Micro SD card to the PLC. The RUN
indicator flashes quickly at a frequency of 4 Hz during downloading.

5. After the user program is downloaded, the RUN indicator flashes slowly at a frequency of 1 Hz
and the PLC enters the "STOP" state. You can remove the GE21-TF-RTC expansion card now.
If the ERR indicator flashes slowly, the attempt to download the user program fails. Check whether
the downloaded file is applicable to the PLC model and whether the login password of the
downloaded file is the same as that of the PLC. If the model and password are both correct but the
download still fails, contact Inovance for technical support.

6. Re-power on the PLC.

8.4 Maintenance
Unauthorized maintenance or disassembly of this product is inhibited. All liabilities arising from such unauthor-
ized interventions shall be solely borne by the operator.

For maintenance upon fault, contact Inovance service personnel to deliver the faulty product to the
designated address.

Requirements before product repair:
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● The fault symptoms are described clearly.
● Make sure whether the accessories need to be replaced. If yes, contact Inovance service

personnel.
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9 Appendix

9.1 Appendix 1: Dimension Diagram

● Dimensions of DIN rail in mm

● Dimensions of PLC in mm

Model Width A/mm
Easy321-3624ER 205

Easy321-3624TP 205

Easy321-3624TN 205

Easy511-3624TN 205

Easy321-2416ER 155

Easy321-2416TP 155

Easy321-2416TN 155

Easy511-2416TN 155

● Dimensions of the end cover in mm

● Dimensions of cables in mm
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9.2 Appendix 2: Spare Parts

Name Diagram Material code

End cover

20215208

DIN rail mounting hook

20213027
20212837

Input power
supply terminal

PLC (relay
model)

15212449

PLC (transistor
model)

15212449
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Name Diagram Material code

24 V power output terminal 15212449

RS485 terminal 15212449

9.3 Appendix 3: Applicable Products

GE21 expansion card

Model Description Slot

supported

Material code

GE21-CAN-485 PLC controller option - GE21-CAN-485-GE21 series CAN and RS485

communication card

A 01480073

GE21-TF-RTC PLC controller option - GE21-TF-RTC-GE21 series TF card (integrated with

RTC)

B 01480074

GE21-RTU PLC controller option - GE21-RTU-GE21 series coupler configuration card B 01480069

GE21-4AD1DA-I GE21 series expansion card with four analog inputs and one analog output

(current type)

A/B 01480070

GE21-8DI GE20 series 8-channel digital input card A/B 01480088

GE21-8DO-TN GE21 series 8-channel digital sink transistor output card A/B 01480090

GE21-232/485-RTC GE21 series RS232 or RS485 communication card (integrated RTC) B 01480072

GE21-8DO-TP GE21 series 8-channel digital source transistor output card A/B 01480089

GE21-4AD1DA-V GE21 series expansion card with four analog inputs and one analog output

(voltage type)

A/B 01480071
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GL20 series expansion module

Module Model Description Material code Power

consump

tion

Digital

GL20-0016ETP 16-channel digital transistor PNP output module 01440292 100 mA

GL20-1600END 16-channel digital input module (NPN/PNP) 01440291 120 mA

GL20-0016ETN 16-channel digital transistor NPN output module 01440293 145 mA

GL20-0800END 8-channel digital input module 01440381 105 mA

GL20-0008ETP 8-channel digital transistor PNP output module 01440380 80 mA

GL20-0008ETN 8-channel digital transistor NPN output module 01440379 115 mA

GL20-0808ETN Digital hybrid module with 8 inputs and 8 outputs 01440339 130 mA

GL20-0008ER 8-channel relay output module 01440334 110 mA

GL20-3200END 32-channel digital transistor input module 01440466 85 mA

GL20-0032ETN 32-channel digital transistor NPN output module 01440467 80 mA

GL20-0404ETP-5V 4-channel digital transistor PNP output module 01440506 90 mA

GL20-3232ETN-M 32-point digital input and 32-point transistor NPN output module

(cables XA3210A-40-L0.5M-01 and T024-K required)

01440290 250 mA

Analog

GL20-4AD 4-channel analog input module (sampling cycle 1 ms/channel) 01440288 95 mA

GL20-4DA 4-channel analog output module 01440287 70 mA

GL20-8ADV 8-channel analog input module - voltage type 01440482 65 mA

GL20-8ADI 8-channel analog input module - current type 01440489 65 mA

Temperature

measure

ment

GL20-4PT 4-channel thermal resistor temperature detection module 01440337 95 mA

GL20-4TC 4-channel thermocouple module 01440338 95 mA

Process

module

GL20-2SSI 2-channel encoder input module (SSI protocol) 01440445 115 mA

Power supply

module

GL20-PS2 Relay power supply module 01440351 55 mA

Communica

tion module

GL20-2S485 2-channel RS485 expansion module (Inovance PLC supported

only)

01440456 155 mA

GL20-2SCOM 2-channel RS232/RS485/RS422 communication module

(Inovance PLC supported only)

01440463 170 mA

9.4 Appendix 4: Recycle and Disposal

Recycle and dispose of the PLC according to environmental protection requirements. Contact a
qualified company for electronic waste disposal and dispose of the product according to the
applicable regulations in the country/region.
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DC

DC (Distributed Clock) is a clock synchronization mode of the EtherCAT bus that is used to ensure
clock synchronization of all devices in the network. Each slave device has a local clock, which is
calibrated through the synchronization signal sent by the master to ensure that all EtherCAT devices
in the entire system are running under a common clock, thus controlling the synchronization
execution of each device task.

SM

SM (SyncManager) is a clock synchronization mode on the EtherCAT bus that ensures clock
synchronization of all devices in the network. The synchronization mode is triggered by SYNC events
to ensure that all devices perform data processing and update at the same time, thus controlling the
synchronization execution of tasks of each device.

Term
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Service and Support

Should you encounter a safety accident during the use or operation of the product, or face
challenges in operating and maintaining the equipment, which remain unresolved after the relevant
documentation is consulted, we provide multiple channels to ensure prompt resolution:

● Channel 1: Pay attention to Inovance Technology Services WeChat public number. Click Smart
Customer Service to enjoy 7 x 24-hour product support services, including function application
consulting. Troubleshooting instructions, obtaining manual materials, etc.

● Channel 2: Call the national unified service hotline: 4000-300124. Service hours: Monday to
Saturday, 8:30 to 12:00 and 13:30 to 17:30.

● Channel 3: Visit Inovance website (www.inovance.com) to enjoy downloading materials, pre-
sales consulting, and after-sales support. Service such as return repair application and
authentication.

● Channel 4: For equipment installation and commissioning, warranty fault handling, factory-
based co-production, and spare parts purchase, For maintenance and other services, you can
visit the Inovance app-service store on Palm Beach to place orders (download link:https://zshc.
inovance.com/downloador download the experience to the mobile app market/app store).

We are committed to providing you with quick and professional technical support, and we look
forward to your satisfaction and trust.

Service and Support
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